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ご注意

保証

HP製品、 またはサービスの保証は、 当該製品、 およびサービスに付随する明示的な保証文によってのみ規定されるものと し

ます。 こ こでの記載で追加保証を意図するものは一切あ り ません。 こ こに含まれる技術的、 編集上の誤り、 または欠如につい

て、 HPはいかなる責任も負いません。

こ こに記載する情報は、 予告なしに変更されるこ とがあ り ます。

権利の制限

機密性のあるコンピュータ  ソフ ト ウェアです。 これらを所有、 使用、 または複製するには、 HPからの有効な使用許諾が必要

です。 商用コンピュータ  ソフ ト ウェア、 コンピュータ  ソフ ト ウェアに関する文書類、 および商用アイテムの技術データは、

FAR12.211および12.212の規定に従い、 ベンダーの標準商用ライセンスに基づいて米国政府に使用許諾が付与されます。

著作権について

© Copyright 2002  2005, 2007  2009 Hewlett-Packard Development Company, L.P. 

商標について

Microsoft® および Windows® は、 米国における  Microsoft Corporation の登録商標です。 
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ドキュ メン トの更新情報

このマニュアルの表紙には、 以下の識別情報が記載されています。

• ソフ ト ウェアのバージ ョ ン番号は、 ソフ ト ウェアのバージ ョ ンを示します。

• ドキュ メン ト  リ リース日は、 ドキュ メン トが更新されるたびに変更されます。

• ソフ ト ウェア リ リース日は、 このバージ ョ ンのソフ ト ウェアのリ リース期日を表します。

最新の更新のチェッ ク、 またはご使用のドキュ メン トが最新版かど うかのご確認には、 次のサイ ト をご利用ください。

http://h20230.www2.hp.com/selfsolve/manuals 

このサイ ト を利用するには、 HP パスポートへの登録とサインインが必要です。 HP パスポート ID の取得登録は、 次の Web
サイ トから行な う こ とができます。 

http://h20229.www2.hp.com/passport-registration.html 

または、 HP パスポートのログイン ページの [New users - please register] リ ンクをク リ ッ ク します。

適切な製品サポート  サービスをお申し込みいただいたお客様は、 最新版をご入手いただけます。 詳細については、 HP の営業

担当にお問い合わせください。
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サポート

次の HP ソフ ト ウェアサポート  オンライン Web サイ ト  を参照してください。

http://www.hp.com/go/hpsoftwaresupport 

HP ソフ ト ウェアが提供する製品、 サービス、 サポートに関する詳細情報をご覧いただけます。

HP ソフ ト ウェア サポート  オンラインではセルフソルブ機能を提供しています。 お客様の業務の管理に必要な対話型の技術支

援ツールに素早く効率的にアクセスいただけます。 HP ソフ ト ウェアサポート  Web サイ トのサポート範囲は次のとおりです。

• 関心のある技術情報の検索

• サポート  ケース とエンハンス メン ト要求の登録と ト ラ ッキング

• ソフ ト ウェア パッチのダウンロード

• サポート契約の管理

• HP サポート窓口の検索

• 利用可能なサービスに関する情報の閲覧

• 他のソフ ト ウェア カスタマとの意見交換

• ソフ ト ウェア ト レーニングの検索と登録

一部を除き、 サポートのご利用には、 HP パスポート  ユーザーと してご登録の上、 ログインしていただく必要があ り ます。 ま

た、 多くのサポートのご利用には、 サポート契約が必要です。

アクセス  レベルに関する詳細は、 以下のWeb サイ ト を参照してください。

http://h20230.www2.hp.com/new_access_levels.jsp 

HP パスポート ID を登録するには、 以下の Web サイ トにアクセスして ください。

http://h20229.www2.hp.com/passport-registration.html
4



目次
第 1 章 Smart Plug-in for Microsoft Exchange Server の概要. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9

Smart Plug-in for Microsoft Exchange Server について . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10

Microsoft Exchange SPI のコンポーネン ト  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10
ポ リシー . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10
ツール . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10
レポート . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11
グラフ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11

Microsoft Exchange SPI の機能  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11
サービスマップ ビュー . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12
メ ッセージブラウザ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
レポートおよびグラフ  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
HP Operations Topology Viewer ツール . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
EXSPI 設定ユーティ リ ティ  ツール . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .14

SAN 環境での Microsoft Exchange 2007 Server の監視 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .14

第 2 章 Microsoft Exchange SPI のインストールとアップグレード . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .15

インス トール パッケージ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .17
SPI パッケージ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .17
グラフ作成パッケージ  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
レポート  パッケージ  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
コンソール パッケージ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18

Microsoft Exchange SPI のインス トール環境  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
HPOM 8.10 サーバーへの SPI コンポーネン トの標準インス トール  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
リモート  コンソールへの標準インス トール  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19
スタンドアロンの HP Reporter または HP Performance Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19

Microsoft Exchange SPI をインス トールするための前提条件 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19
ハードウェア要件 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19
ソフ ト ウェア要件 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19

Microsoft Exchange SPI のインス トール . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .20
リモート  コンソールへの Microsoft Exchange SPI のインス トール  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .20
スタンドアロン管理サーバーへの Microsoft Exchange SPI のインス トール. . . . . . . . . . . . . . . . . . . . . . . . . . .20
HPOM ク ラスタ環境への Microsoft Exchange SPI のインス トール . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .22

Microsoft Exchange SPI のアップグレード  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .22
リモート  コンソールでの Microsoft Exchange SPI のアップグレード  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .22
スタンドアロン管理サーバーでの Microsoft Exchange SPI のアップグレード . . . . . . . . . . . . . . . . . . . . . . . . .23
HPOM ク ラスタ環境での Microsoft Exchange SPI のアップグレード  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .24

Microsoft Exchange SPI のインス トール /アップグレードの確認 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .24
 5



第 3 章 Microsoft Exchange SPI の設定. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .27

基本的な設定手順. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28
非管理ノードの管理ノードへの変更  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28
管理ノードへのインス トルメンテーシ ョ ン カテゴ リの配布 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .29
ツールの実行 ‐ [デー タ  ソースの作成 ]、 [DataCollector の登録 ]、 [PowerShell Collector の起動 ]  . . . . . . . . .30

PowerShell Collector ツールの起動 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .31
EXSPI-8X Check Collector Server_jp ポ リシーの資格情報の入力. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .34
ポ リシーのカスタマイズ  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .34
管理ノードへの Microsoft Exchange SPI ポ リシーの配布 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .35

データのログ記録のシナリオ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38

検出の設定のシナリオ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38
検出ポリシーの編集 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38
管理ノードへの検出ポリシーの配布  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .40
サービス  マップの表示 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .42

その他の設定手順. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .43
EXSPI データ  コレクタの機能. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .43
EXSPI 設定ユーティ リ ティ  ツール . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .44

EXSPI 設定ユーティ リ ティの使用  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .44
EXSPI 設定ユーティ リ ティの表示  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .45

EXSPI 設定ユーティ リ ティのメニューバー  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .46

EXSPI 設定ユーティ リ ティのツールバー . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .47

EXSPI 設定ユーティ リ ティのペイン . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .48
収集設定の保存. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .48

[File] → [Save] オプシ ョ ン  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .49

[File] → [Save As] オプシ ョ ン . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .49
収集データの追加 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .49

MetricSet の追加  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .49

OpCMsg Call の追加  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .55

OpCMon Call の追加 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .58

DataStore の追加 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .59

収集設定の追加 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .61
収集の変更  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66

MetricSet の変更  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66

OpCMsg Call の変更  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .67

OpCMon Call の変更 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .69

DataStore の変更 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .69

収集設定の変更 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .70
追加 cmdlet の使用. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71

Exchange Server ク ラスタ環境での Microsoft Exchange SPI の設定 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .72
ポ リシー名の変更のための追加設定  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .76
Exchange ク ラスタ  サービス用のマップ ビュー . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .76
6



第 4 章 ポリシーの使用  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .79

ポ リシー グループとポ リシー タイプ  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .79
ポ リシー グループ  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .79
ポ リシー タイプ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .80

第 5 章 ツールの使用. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .83

Microsoft Exchange ツールの起動  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .83
HP Operations Topology Viewer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .83

HP Operations Topology Viewer の使用 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .83

HP Operations Topology Viewer のツールバー  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .84

HP Operations Topology Viewer のメニュー  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .86

HP Operations Topology Viewer のマップ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .89

第 6 章 レポート作成およびグラフ作成ソリューシ ョ ンと  Microsoft Exchange SPI の統合 . . . . .91

レポート とグラフの使用  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .91

Microsoft Exchange SPI を HP Reporter に統合 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .91
レポート  パッケージのインス トールまたはアップグレード . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .92
レポート  パッケージの設定 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .92
レポートの生成. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .93

Microsoft Exchange SPI を HP Performance Manager に統合 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .94
グラフの生成  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .95

第 7 章 ト ラブルシューテ ィング . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .97

検出のト ラブルシューティング . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .97
不十分な権限  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .97
管理ノード上のバイナリの失敗 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .97
管理ノード上の検出バイナリのタイムアウ ト  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .98

ト レースによる ト ラブルシューティング . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .98

レポートおよびグラフの ト ラブルシューティング  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .99
レポートおよびグラフが生成されない. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .99
データ  ログ ポ リシーでデータをログ記録できない. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .100
HTML レポートの表示中にブラウザがク ラ ッシュする  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .100
Oracle データベースでレポートが失敗する  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .100

ポ リシー名の変更. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .101

第 8 章 Microsoft Exchange SPI の削除. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .103

DVD を使用する方法 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .103
Microsoft Exchange SPI コンポーネン トの削除 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .103

Windows の [ コン ト ロール パネル ] を使用する方法  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .104
管理サーバーからの Microsoft Exchange の削除  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .104
レポート作成パッケージの削除 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .104
グラフ作成パッケージの削除 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .104

.msi ファ イルを使用したレポート作成パッケージとグラフ作成パッケージの削除 . . . . . . . . . . . . . . . . . . . . . . . .105
.msi ファ イルを使用したレポート作成パッケージの削除 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .105
.msi ファ イルを使用したグラフ作成パッケージの削除. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .105
7



A Microsoft Exchange SPI インストルメンテーシ ョ ン ファイル一覧 . . . . . . . . . . . . . . . . . . . . . 107
Exchange2k7_Collector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .107

Exchange 2k7_Core . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .107

Exchange2k7_Discovery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .111

索引 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .113
8



第1章 Smart Plug-in for Microsoft Exchange Server 
の概要
Smart Plug-in (SPI) は、 HP Operations Manager (HPOM) 用のプラグインまたはアドオン ソフ ト ウェア

です。 これは HPOM のモジュラ  コンポーネン ト と して機能し、 IT リ ソースの管理においてその監視機能を

さらに向上させます。 SPI は、 以下によ りユーザー環境のタスクの簡素化を支援します。

• 可用性と稼動状態の監視

• パフォーマンス低下の検出

• 問題の検出、 予防、 および解決

• 問題の解決法の文書化

• レポートの生成

図1　 　HPOM クライアン ト構造アーキテクチャ
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Smart Plug-in for Microsoft Exchange Server について

Smart Plug-in for Microsoft Exchange Server (Microsoft Exchange SPI) によ り、 使用環境における

Microsoft Exchange Server 2007 の管理に役立ちます。 Microsoft Exchange SPI によ って、 Microsoft
Exchange Server 2007 に関する状態が通知され、 以下の更新情報が提供されます。

• Microsoft Exchange Server の可用性とその役割

• Microsoft Exchange Server で発生するイベン トの監視

• Microsoft Exchange Server の各種機能の監視

• メール フローの遅延、ト ランスポート  エージェン トのキューの長さ、インフォ メーシ ョ ン ス ト アのデー

タベース  キャ ッシュ  サイズ、 スパム統計などの特に重要なメ ト リ ッ クの監視とレポート作成

• ExBPA の統合

Microsoft Exchange SPI によ り、 分散した Microsoft Exchange 環境を、 中央の使いやすいコンソールから

監視できます。 ネッ ト ワークやシステムに対して使用しているパフォーマンスや問題の管理プロセスで、

Microsoft Exchange Server 2007 を監視できます。 Microsoft Exchange SPI には、 以下の機能があ り ます。

• Microsoft Exchange の可用性とパフォーマンスの向上

• Microsoft Exchange サービスに関連するサポート  コス トの削減

• Microsoft Exchange の容量管理と計画の改善

Microsoft Exchange SPI のコンポーネン ト

Microsoft Exchange SPI のコンポーネン トは、 ポ リシー、 ツール、 レポート、 およびグラフです。 これらの

各コンポーネン トが、 Microsoft Exchange SPI の監視機能を強化します。

ポリシー

ポ リシーとは、Microsoft Exchange Server 2007 環境を絶えず監視し、サービス  マップ警告と メ ッセージの

形式で監視スケジュールを改善する、事前に定義されたしきい値です。 サービス  マップ警告はサービス  マッ

プに表示され、 メ ッセージはメ ッセージ ブラウザに表示されます。 Microsoft Exchange SPI には、 さまざま

なポ リシーがあ り ます。 ポ リシーに関する詳細は、 第 4 章 「ポ リ シーの使用」 を参照してください。

ツール

ツールとは、よ り多くの Microsoft Exchange Server 2007 関連情報を設定および収集するユーティ リ ティで

す。 Microsoft Exchange SPI ツールを活用する こ とで、 管理ノード上で Microsoft Exchange Server 2007
の監視を簡素化するための特定のタスクを実行できます。 ツールを使用して、Microsoft Exchange SPI を設

定するこ と もできます。 たとえば、EXSPI 設定ユーティ リ ティやデータ  ソースの作成ツールです。 ツールに

関する詳細は、 第 5 章 「ツールの使用」 を参照してください。
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レポート

レポートは、 Microsoft Exchange Server 2007 のさまざまなメ ト リ ッ クを画像を使用して表現したもので

す。 ポ リシーによって収集されたデータが、生成に使用されます。 レポートに関する詳細は、第 6 章 「レポー

ト作成およびグラフ作成ソ リ ューシ ョ ンと  Microsoft Exchange SPI の統合」 を参照してください。

グラフ

グラフは、 Microsoft Exchange Server 2007 のさまざまなメ ト リ ッ クを表現したものです。 グラフには、 ポ

リシーによって収集されたデータが含まれています。 グラフに関する詳細は、 第 6 章 「レポート作成および

グラフ作成ソ リ ューシ ョ ンと  Microsoft Exchange SPI の統合」 を参照してください。

HP Reporter および HP Performance Manager を使用して生成されたレポート とグラフでは、 長期的にと

る修復措置を決定するのに役立つ概要情報が得られます。

ポ リシー、ツール、レポート、およびグラフの詳細については、『HP Operations Smart Plug-in for Microsoft
Exchange Server オンライン ヘルプ』または『HP Operations Smart Plug-in for Microsoft Exchange Server
オンライン ヘルプ』 の PDF を参照して ください。

Microsoft Exchange SPI の機能

Microsoft Exchange SPI を設定した後、 Microsoft Exchange Server 2007 環境に関する重要な情報を、

HPOM コンソールから以下の形式で表示するこ とができます。

• サービス  マップ ビュー

• メ ッセージ警告

• レポートおよびグラフ

• ト ポロジー ビューア ツール

• EXSPI 設定ユーティ リ ティ  ツール
Smart Plug-in for Microsoft Exchange Server の概要 11



サービスマップ ビュー

HPOM のマップ ビューは環境の Microsoft Exchange Server 2007 のグラフ ィ カルで構造的なビューを表

示し ます。 Microsoft Exchange SPI は Microsoft Exchange Server 2007 ノー ド と  Microsoft Exchange
Server 2007 サービスを検出して、 これらをマップ ビューに表示します。 マップ ビューには、 Microsoft
Exchange Server 2007 環境のほぼリ アルタイムの状況が表示されます。 

マップ ビューでは、 Microsoft Exchange 組織における問題の重要度レベルが色 (赤と青 ) で表示されます。
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メ ッセージブラウザ

Microsoft Exchange SPI は管理ノード  (Microsoft Exchange Server 2007 がインス トールされていて、 HP
Operations エージェン トが配布されているサーバー ) のイベン トおよびサービスを監視し、 メ ッセージを生

成します。 メ ッセージは HPOM コンソールのメ ッセージ ブラウザに表示されます。 

Microsoft Exchange SPI には、 以下の 2 つのメ ッセージ グループがあ り ます。

• EXSPI_2007: Microsoft Exchange SPI ポ リ シーからの、 Exchange サーバーのステータスに関する警

告が含まれます。

• EXSPI_2007_Errors: Exchange 2007 Server の監視プロセスで発生した Microsoft Exchange SPI の
コード例外に関する警告が含まれます。

レポートおよびグラフ

Microsoft Exchange SPI を HP Reporter および HP Performance Manager と統合すれば、収集されたメ ト

リ ッ ク  データに基づいてレポートおよびグラフを生成する こ とができます。 HP Reporter はノードで収集

したデータを取得およびフォーマッ ト し、 Web ベースのレポート を生成します。 HP Performance Manager
は管理ノードで収集された、 ほぼ リ アルタ イムに近いデータからグラフを生成します。 HP Performance
Manager を HPOM 管理サーバーにインス トールしていれば、 HPOM コンソールから これらのグラフにア

クセスできます。

HP Operations Topology Viewer ツール

Microsoft Exchange SPI では、 ルーテ ィ ング グループとサーバー接続を示す 3 次元マップを使用して、

Microsoft Exchange 組織をグラフ ィカルに表示するこ とができます。 ト ポロジー ビューからは、ルーティン

グ グループや Exchange サーバー、 およびそれらが Exchange 組織内で果たす役割を簡単に確認できます。
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図 4 に、 ト ポロジー ビ ューを示し ます。 HP Operations Topology Viewer ツールに関する詳細は、 HP
Operations Topology Viewer (83ページ ) を参照してください。

EXSPI 設定ユーティ リテ ィ  ツール

EXSPI 設定ユーティ リ ティ  ツールでは、Microsoft Exchange SPI の収集設定データを編集できます。 また、

必要に応じて、 新しい収集やメ ト リ ッ クを作成した り、 変更した りする こ と もできます。 EXSPI 収集設定

ユーティ リ ティ  ツールに関する詳細は、 その他の設定手順 (43ページ ) を参照してください。 

SAN 環境での Microsoft Exchange 2007 Server の監視

Microsoft Exchange Server の高可用性によって、 ス ト レージの統合、 メ ッセージング システムの中央管理

への移行、データのリ アルタイム監視を行っている  SAN 環境で、Microsoft Exchange SPI を使用できます。

Microsoft Exchange SPI は、 外部 SAN ス ト レージに設定された Microsoft Exchange データベース  ( イン

フォ メーシ ョ ン ス ト ア ) からこれらのアクティビティを監視します。
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第2章 Microsoft Exchange SPI のインストールと

アップグレード
Microsoft Exchange SPI をインス トールおよびアップグレードするには、以下のセクシ ョ ンに示すタスクを

実行します。

次のフローチャートに、 Microsoft Exchange SPI のインス トールおよび設定の概要を示します。 凡例の参照

については、 表 1 を参照してください。

図2　 　 インストールおよびアップグレード手順の概要

Microsoft Exchange SPI バージ ョ ン 13.00 にアップグレードする場合、 「Microsoft Exchange SPI のアッ

プグレード」 の手順を実施した後、 Microsoft Exchange SPI をインス トールして ください。
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表 1　 　 フローチャートの凡例の参照

次のフローチャートに、 Microsoft Exchange SPI のアップグレードの概要を示します。 凡例の参照について

は、 表 2 を参照してください。

凡例 参照

A Microsoft Exchange SPI をインス トールするための

前提条件 (19ページ ) 

B Microsoft Exchange SPI のインス トール (20ページ ) 

C Microsoft Exchange SPI のインス トール /アップグ

レードの確認 (24ページ ) 

D 非管理ノードの管理ノードへの変更 (28ページ ) 

E 管理ノードへのインス トルメンテーシ ョ ン カテゴ リ

の配布 (29ページ ) 

F ツールの実行 ‐ [デー タ  ソースの作成 ]、 
[DataCollector の登録 ]、 [PowerShell Collector の起

動 ] (30ページ ) 

G 検出ポリシーの編集 (38ページ ) 

H 管理ノードへの検出ポリシーの配布 (40ページ ) 

I サービス  マップの表示 (42ページ ) 

J 検出のト ラブルシューティング (97ページ ) 

K ポ リシーのカスタマイズ (34ページ ) 

I 管理ノードへの Microsoft Exchange SPI ポ リ シーの

配布 (35ページ ) 
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図3　 　アップグレード手順の概要

表 2　 　 フローチャートの凡例の参照

インス トール パッケージ

Microsoft Exchange SPI のインス トール パッケージには、SPI パッケージ、グラフ作成、 レポート作成、お

よびコンソール パッケージが含まれています。

SPI パッケージ

SPI パッ ケージは .msi パッケージであ り、 SPI のすべての機能が含まれています。 このパッケージは、

HPOM サーバーにインス トールする必要があ り ます。 Microsoft Exchange SPI パッケージは、 以下の場所

にあ り ます。

凡例 参照

A Microsoft Exchange SPI のポ リシー グループおよび

ツール グループ [SPI for Exchange] の名前を、 [SPI for 

Exchange_OLD] に変更します。 (23ページ ) 

B Microsoft Exchange SPI のインス トール (20ページ ) 

C Microsoft Exchange SPI のインス トール /アップグ

レードの確認 (24ページ ) 

D Microsoft Exchange SPI の設定 (27ページ ) 
Microsoft Exchange SPI のインストールとアップグレード 17



<SPI DVD>\SPIs\Exchange SPI\EXSPI-Server.msi 

グラフ作成パッケージ

このグラフ作成パッケージには、 SPI で提供されるグラフが含まれています。 グラフは、 SPI によって作成

されたデータ  ソースで収集された メ ト リ ッ クから描画されます。 Microsoft Exchange SPI のグラフ作成

パッケージは、 以下の場所にあ り ます。

<SPI DVD>\SPIs\EX SPI OVPM ConfigurationPackage\HPOvSpiExGc.msi

レポート  パッケージ

この Reporter パッケージには、 SPI で提供されるレポートが含まれています。 Reporter は、 SPI によって

管理されている ノードからデータを収集し、 ローカルのデータベースに保存して、デフォルトの SPI レポー

ト  ポ リ シーに基づいて .html レポート を作成します。 Microsoft Exchange SPI のレポート作成パッケージ

は、 以下の場所にあ り ます。

<SPI DVD>\SPIs\Exchange SPI Reporter Package\EXSPI-Reporter.msi

コンソール パッケージ

コンソール パッケージには、HP Operations Topology Viewer ツールと  EXSPI 設定ユーティ リ ティ  ツール

が含まれています。 Microsoft Exchange SPI のコンソール パッケージは、 以下の場所にあ り ます。

• HP Operations Topology Viewer ツール : 

<SPI DVD>\SPIs\SPIs Console Packages\OVTV-Console.msi

• EXSPI 設定ユーティ リ ティ :

<SPI DVD>\SPIs\SPIs Console Packages\EXSPI-Console.msi

Microsoft Exchange SPI のインストール環境

HPOM for Windows は、 エンタープライズ アプリ ケーシ ョ ン サーバーをスケーラブルに監視する機能を提

供します。 SPI は、 このスケーラブルなアーキテクチャの一部と して、 特定のアプリ ケーシ ョ ン サーバーの

監視を可能にします。

HPOM 8.10 サーバーへの SPI コンポーネン トの標準インストール

デフォルトでは、 HPOM for Windows 8.10 サーバーに OVPMLite と  ReporterLite がインス トールされま

せん。 インス トールでは、SPI 製品のフル バージ ョ ンだけが利用できます。 そのため、HP Operations Smart
Plug-Ins DVD では、 SPI パッケージだけを選択でき、 レポート とグラフの作成用パッケージは選択できま

せん。 ただし、 同じマシンに Reporter または Performance Manager のフル バージ ョ ンがインス トールさ

れている場合は、 対応するパッケージのインス トールまたはアンインス トールを HPOM 8.10 サーバーで行

う こ とができます。
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リモート  コンソールへの標準インストール

SPI DVD に収録されたすべてのリモート  コンソール パッケージは、 リモート  コンソールに一度にインス

トールされます。 特定のリモート  コンソール パッケージを選択するためのオプシ ョ ンはあ り ません。

スタンドアロンの HP Reporter または HP Performance Manager

スタン ドアロンの HP Reporter または HP Performance Manager がインス トールされているシステムで

は、 HP Operations Smart Plug-ins DVD の SPI の対応するパッケージだけが有効になり、使用するこ とが

できます。 たとえば、 HP Reporter だけがインス トールされているシステムには、 SPI のレポータ  パッケー

ジをインス トールできます。 グラフ作成パッケージと  HP Performance Manager についても同様です。

Microsoft Exchange SPI をインストールするための前提条件

Microsoft Exchange SPI をインス トールする前に、 ハード ウェアと ソフ ト ウェアの要件を満たして くださ

い。 また、 Microsoft Exchange SPI をインス トールする前に、 HPOM サーバーをインス トールして くださ

い。 Microsoft Exchange SPI のインス トールを始める前に HPOM セッシ ョ ンを停止する必要はあ り ませ

ん。 

ハードウェア要件

ハードウェア要件の詳細は、『HP Operations Manager for Windows インス トール ガイ ド』 を参照してくだ

さい。

ソフ トウェア要件

以下のソフ ト ウェア要件が満たされているこ とを確認して ください。

管理サーバー :

• HP Operations Manager for Windows: 8.10 および最新のパッチ

• HP Reporter: 3.80

• HP Performance Manager: 8.20 (グラフを生成する場合)

• HP Operations SPI Data Collector (DSI2DDF): 2.40

• HP SPI セルフ ヒーリ ング サービス  (SPI-SHS-OVO は SPIDVD を使用した SPI のインス トール時に

自動的にインス トールされる ): 3.00 

管理ノード :  

• HP Operations エージェン ト  (バージ ョ ン 8.53 または 8.60 (HTTPS) および 7.35 (DCE)) がインス トー

ルおよび設定されているこ と

• HP Performance Agent: 5.00 (データのログ記録に HP Performance Agent を使用する場合、 必須 )

HPOM コンソール、 管理サーバー、 およびエージェン ト をインス トールして、 Microsoft Exchange SPI を
有効にする必要があ り ます。
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Microsoft Exchange SPI のインストール

HPOM for Windows 8.10 に Microsoft Exchange SPI をインス トールします。 リ モート  コンソールまたは

スタンドアロン管理サーバーにインス トールできます。

リモート  コンソールへの Microsoft Exchange SPI のインストール

HPOM リモート  コンソールには、Microsoft Exchange SPI のコンソール パッケージのみインス トールしま

す。

スタンドアロン管理サーバーへの Microsoft Exchange SPI のインストール

HP Operations Smart Plug-ins DVD には、Microsoft Exchange SPI が収録されています。 管理サーバーに

Microsoft Exchange SPI をインス トールするには、 以下の手順に従います。

1 Smart Plug-ins DVD を管理サーバー システムまたはコンソール システムの DVD ド ラ イブに挿入し

ます。 インス トール ウ ィザードが開きます。

2 [次へ ] をク リ ッ ク して次に進みます。 [SPl リ リース ノートおよび他のドキュ メン ト ] 画面が表示されま

す。

3 [次へ ] をク リ ッ ク します。 [製品の選択 ] 画面が表示されます。
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4 [次へ ] をク リ ッ ク します。 [自動配布の有効化 / 無効化 ] 画面が表示されます。

5 [有効化] または [無効化] ボタンを選択し、 [次へ ] をク リ ッ ク します。 [使用許諾契約 ] 画面が表示されま

す。

6 [使用許諾契約書の条項に同意します ] オプシ ョ ンを選択するこ とによって、 使用許諾条件に同意し、 [次

へ ] をク リ ッ ク します。 [プロ  グラムをインス トールする準備ができました ] 画面が表示されます。
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7 [戻る ] を選択する と、 前の選択内容を編集できます。 編集しない場合、 [ インストール ] をク リ ッ ク して

インス トールを開始します。 インス トールが開始されます。 ウ ィザードはコアの SPI、 必要なすべての

パッケージ、 および Microsoft Exchange SPI をインス トールします。

8 インス トールが完了した後、 [完了 ] をク リ ッ ク します。

HPOM クラスタ環境への Microsoft Exchange SPI のインストール 

Microsoft Exchange SPI を ク ラ ス タ環境にインス ト ールする前に、 ク ラ ス タの各システムに HPOM for
Windows 8.10 がインス トールされているこ とを確認してください。

タスク  1: 最初のクラスタ対応の管理サーバーで、 Smart Plug-in を選択してインストールします。

次の管理サーバーに進む前に、 スタンドアロン管理サーバーへの Microsoft Exchange SPI のインス トール

の手順を完了します。

タスク  2: 次のクラスタ対応の管理サーバーで、 最初の管理サーバーへのインストールで選択した Smart Plug-in をイ

ンストールします。

スタンドアロン管理サーバーへの Microsoft Exchange SPI のインス トールの手順1、 手順2、 および手順8
をク ラスタ内の各管理サーバー上で繰り返し実行します。完了するまで、すべての管理サーバーでインス トー

ルを続行します (HP Operations Manager ク ラスタ  インス トールで定義されている とおり )。

Microsoft Exchange SPI のアップグレード

各種環境で Microsoft Exchange SPI をアップグレードするには、 以下のセクシ ョ ンに示すタスクを実行し

ます。

リモート  コンソールでの Microsoft Exchange SPI のアップグレード

リ モー ト  コンソールで HPOM を使用している場合は、 以下のよ うにコンソールのみのシステムの Smart
Plug-in アップグレード手順に従ってください。

インス トールを開始した後、 [キャンセル ] ボタンを選択しても、 インス トール プロセス全体は中止されませ

ん。 現在インス トール中の製品 ( ステータス領域に表示されている ) のインス トールのみが中止され、 選択

した次の製品のインス トールが開始します。

Microsoft Exchange SPI を HPOM ク ラ スタのすべてのノードにインス トールするまでは、 HPOM コン

ソールは正し く機能しません。

開始する前に、 Microsoft Exchange SPI 用の十分なディ スクの空き容量が各管理サーバーにあるこ とを確

認して ください。 インス トール中にインス トールをキャンセルする と、 一部のコンポーネン トだけがインス

トールされ、 それらのインス トール済みのコンポーネン ト を手動で削除する必要がある場合があ り ます。

 

ク ラスタのすべてのノードでのインス トールが完了するまで、 HPOM コンソールは正し く機能しません。

Microsoft Exchange SPI 12.10 から  13.00 にアップグレードする前に、 管理サーバーからサービス検出の

Exchange 2007 Discovery_jp ポ リシーを削除します。
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1 コンソールのみに使用するシステムの DVD ド ラ イブに、 HP Operations Smart Plug-ins DVD を挿入

します。

2 インス トール済みのリモート  コンソールが検出されたこ とを示すダイアログ ボッ クスが表示されるま

で、 画面の説明に従ってください。

3 [次へ ] をク リ ッ ク します。

インス トールされている既存のパッケージすべてがアップグレード されます。

スタンドアロン管理サーバーでの Microsoft Exchange SPI のアップグレード

スタンド アロン管理サーバーで Microsoft Exchange SPI をアッ プグレード するには、以下の手順に従います。

1 Microsoft Exchange SPI のポリ シー グループおよびツール グループ [SPI for Exchange] の名前を、[SPI

for Exchange_OLD] に変更します。 

2 Microsoft Exchange SPI 13.00 のインス トール スタンドアロン管理サーバーへの Microsoft Exchange
SPI のインス トールを参照して ください。

3 すべての管理対象 Microsoft Exchange サーバーのツール グループ [SPI for Exchange_OLD] から、

[Stop Collection Manager ] および [Stop Collector Server ] ツールを実行します。 ノードで、収集マネー

ジャ と コレクタ  サーバーが停止されます。

4 インス トルメンテーシ ョ ン グループ Exchange2k7_Core を、 すべての管理対象 Microsoft Exchange
サーバー ノードに配布します。 インス トルメンテーシ ョ ン カテゴ リ を配布するには、管理ノードへのイ

ンス トルメンテーシ ョ ン カテゴ リの配布を参照してください。

5 すべての管理対象 Microsoft Exchange サーバー ノ ード のツール グループ [SPI for Exchange] から、 [古

い EXSPI アーテ ィ フ ァ ク ト の削除 ] ツールを起動し、 ノードに配布されている以前のバージ ョ ンの

Microsoft Exchange SPI ポ リシーおよびインス トルメンテーシ ョ ン カテゴ リ を削除します。

6 すべての管理ノードからデータを収集し、 以下の手順を実行します。

Exchange SPI 13.00 では、 管理ノード上のデータ  ス ト アに記録するデータの形式が異なっています。

HP Reporter も これを使用し ます。 EXSPI データ  ス ト アを再作成する前に、 すべての Microsoft
Exchange 管理ノードから、 以前のすべてのデータ  ソースを収集する必要があ り ます。 そのためには、

以下の手順に従います。 

a HP Reporter サーバーに .NET Framework のバージ ョ ン 2.x 以上をインス トールします。 HP
Operations Smart Plug-in DVD を HP Reporter サーバーのド ライブに挿入します。

b discovery コマンドを実行して HP Reporter サーバー上のすべての管理ノードを検出します。

%OvDataDir%\trace.discover ファ イルをチェ ッ ク して、 すべての Microsoft Exchange 管理

ノードが検出されたこ とを確認します。

c コマンドプロンプ ト を開き、 次のパスまで移動します。 <DVD-Drive>\SPIs\Exchange SPI

d すべての Microsoft Exchange 管理ノードが HP Reporter に検出されるこ とを確認し、 以下のコマ

ンドを実行します。

EXSPI_run_gatherCODA.exe <reporter_system_dsn> <reporter_db_username>
 <reporter_db_password>

この場合、 <reporter_system_dsn> は HP Reporter データベースのシステム DSN、

<reporter_db_username> と  <reporter_db_password> は HP Reporter データベースにアクセス

するためのユーザー名とパスワードです。

HP Reporter サーバーで Microsoft Exchange SPI のレポート作成パッケージをアップグレードする前

に、 以下の手順を実行します。
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e %OvDataDir%\trace.gather ファ イルをチェッ ク してエラーがないか調べます。 すべての管理

対象 Microsoft Exchange ノードから、 すべてのメ ト リ ッ ク  リ ス トのデータが収集されたこ とを確

認します。

7 すべての管理対象 Microsoft Exchange サーバー ノードのツール グループ [SPI for Exchange] から、[古

い EXSPI クラスの削除 ] ツールを起動し、 管理ノードにある以前のバージ ョ ンの Microsoft Exchange
SPI データ  ス ト アを削除します。

8 続けて、 Microsoft Exchange SPI 13.00 の設定を行います。 基本的な設定手順を参照して ください。

HPOM クラスタ環境での Microsoft Exchange SPI のアップグレード

HPOM ク ラスタ環境で Microsoft Exchange SPI をアップグレードするには、 以下のタスクを実行します。

タスク  1: 最初のクラスタ対応の管理サーバーで、 Smart Plug-in を選択してインストールします。

次の管理サーバーに進む前に、 Microsoft Exchange SPI のアップグレードの手順を完了します。

タスク  2: 次のクラスタ対応の管理サーバーで、 最初の管理サーバーへのインストールで選択した Smart Plug-in をイ

ンストールします。

ク ラスタの各管理サーバーで、 スタンドアロン管理サーバーでの Microsoft Exchange SPI のアップグレー

ド  (23ページ ) の手順1、手順2、および手順8を繰り返します。 完了するまで、すべての管理サーバーでアッ

プグレードを続行します (HP Operations Manager ク ラスタ  インス トールで定義されている とおり )。

Microsoft Exchange SPI のインストール/アップグレードの確認

Microsoft Exchange SPI が正し く インス トールまたはアップグレード されたこ とを確認するには、以下のい

ずれかを実行します。

ポ リ シーのカスタマイズを保持するには、 Software Upgrade Tool Kit 2.0 を使用します。 詳細については、

『HP Operations Smart Plug-in Upgrade Toolkit Windows User Guide』 を参照してください。 

インス トールを開始する前に、 Microsoft Exchange SPI 用の十分なディ スクの空き容量が各管理サーバー

にあるこ とを確認して ください。 インス トール中にインス トールをキャンセルする と、 一部のコンポーネン

トだけがインス トールされ、それらのインス トール済みのコンポーネン ト を手動で削除する必要がある場合

があ り ます。

Microsoft 

ク ラスタのすべての Microsoft Exchange ノードでインス トールが完了するまで、HPOM コンソールは正し

く機能しません。
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• ポ リシー グループの下にある  SPI をチェッ ク します。 [ポリシー管理] の下にある  [ポリシー グループ ] を
展開します。 リ ス トの [SPI for Exchange] で、インス トールを確認します。 さ らに [SPI for Exchange] を
展開して、 [Exchange Server 2008] のポ リシーをチェッ クできます。 

• ポ リシーと インス トルメンテーシ ョ ン バイナリのバージ ョ ンが 13.00 であるこ とを確認します。
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第3章 Microsoft Exchange SPI の設定
Microsoft Exchange SPI は、環境内の Microsoft Exchange Server 2007 の既存のコンポーネン ト を検出し、

ポ リ シーによ って設定されたし きい値を保守する こ と で、 Microsoft Exchange Server を監視し ます。

Microsoft Exchange SPI をインス トールした後、 組織の Microsoft Exchange Server 2007 ノードを監視す

るよ うに設定する必要があ り ます。
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基本的な設定手順

Microsoft Exchange SPI を設定するには、 以下のセクシ ョ ンに示すタスクを実行します。

非管理ノードの管理ノードへの変更

非管理ノードを管理ノードに変更するには、 そのノードを HPOM コンソールのノード  フォルダに追加しま

す。 ノードを追加する と、 自動サービス検出プロセスを起動し、 これによって手動で起動したプロセスを再

現できます。 

1 コンソールで、 [ ノード ] を右ク リ ッ ク してから、 [設定 ] → [ ノード ] を選択します。

2 [管理ノードの設定 ] ボッ クスで、 以下の方法のいずれかで非管理ノードを [管理ノード ] に追加します。

― 左ペインで、 追加する各ノードをダブルク リ ッ ク します。

― ノードを左から右にド ラ ッグ アンド  ド ロ ップします。 
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― 左ペインで、 各ノードを右ク リ ッ ク し、 [管理 ] を選択します。 

3 (必要な場合 ) HP Operations エージェン ト  ソフ ト ウェアを実行しているシステムが、左ペインの [検出

されたノード ] フォルダにない場合は、詳細ペインで、 [ ノード ] を右ク リ ッ ク し、 [新規ノード ] を選択し

ます。 次に、 システム名およびその他の関連情報を入力し、 [OK] をク リ ッ ク します。

管理ノードへのインストルメンテーシ ョ ン カテゴリの配布

Microsoft Exchange SPI の以下のインス トルメンテーシ ョ ン カテゴ リ を配布します。

• SPI Data Collector

• Exchange2k7_Core

• Exchange2k7_Collector

• Exchange2k7_Discovery

インス トルメンテーシ ョ ンを配布するには、 以下の手順に従います。

1 HPOM のコンソール ツ リーで、 ノードを右ク リ ッ ク し、 [すべてのタスク ] を選択します。 [プログラムの

配布] を選択します。 [プログラムの配布] ボッ クスが開きます。

2 必須のインス トルメンテーシ ョ ン カテゴ リである  [SPI Data Collector] を選択します。 

EXSPI pssnapin を読み込んだ PowerShell プロンプ トが管理モードで開かれたままになっている と、 設定

の配布が失敗します。
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3 [Exchange2k7_Core]、 [Exchange2k7_Collector]、 [Exchange2k7_Discovery] の各カテゴ リ を選択して、

[OK] をク リ ッ ク します。 

4 他のすべての Exchange 管理ノードで手順 1 ～ 3 を実行します。

ツールの実行 ‐ [デー タ  ソースの作成 ]、 [DataCollector の登録 ]、 [PowerShell 
Collector の起動 ]

各 Microsoft Exchange ノードで、 所定の順序で以下の Exchange SPI ツールを実行します。

• データ  ソースの作成 : [データ  ソースの作成 ] ツールは、 HP Operations エージェン トのデータ  ス ト ア

(組み込みパフォーマンス  コンポーネン ト  (CODA)) または HP Performance Agent にデータベースを

作成します。

ご使用の環境に HP Performance Agent がインス ト ールされていない場合、 ツールはデータ  ス ト ア

(CODA) にデータベースを作成します。 データ  ス ト アは、 個々のコレクタが収集したデータを保存する

こ とができます。

管理ノードに HP PA と  CODA の両方がインス トールされている場合、 CODA にデータ  ソースを作成

するには、空の nocoda.opt ファ イルを作成してから、ツールを起動する前に -CODA オプシ ョ ンを追加

するこ とで [データ  ソースの作成 ] ツール コマンド ラインをカスタマイズします。

詳細については、 データのログ記録のシナリオを参照して ください。

• DataCollector の登録 : [DataCollector の登録 ] ツールは、 ノード上の必須な COM コンポーネン ト を登

録します。 ノードの監視を開始する前にこのツールを実行してください。

このツールは既存の EXSPI データ  ソースの有無をチェッ ク します。 データ  ソースが存在しない場合、

エラー メ ッセージを表示します。 ただし、 [データ  ソースの作成 ] ツールが新しい EXSPI データ  ソー

スの作成を継続するため、 このエラー メ ッセージは無視できます。
30 第 3 章



• PowerShell Collector の起動 : [PowerShell Collector の起動 ] ツールは、 PowerShell Collector を
Exchange ノード上で起動します。 

PowerShell Collector ツールを、 以下の権限を持つユーザーと して起動します。

― Exchange 表示専用管理者

― すべてのメールボッ クス  サーバーの Exchange Server 管理者

― すべてのメールボッ クス  サーバーのローカル管理者

― すべてのメールボッ クス  サーバーの Microsoft Exchange System Object (MESO) への読み取りお

よび書き込みアクセス

ユーザーに対し、MESO への読み取りおよび書き込みアクセス権限を付与するには、以下の手順に従い

ます。

a Microsoft Exchange Server が属する ド メ インの DC で、 Active Directory Users & Computers ス
ナップインを開きます。

b [View] → [Advanced Features] が選択されているこ とを確認します。

c Microsoft Exchange Systems Object コンテナを参照して右ク リ ッ ク し、 [Properties] を選択します。

d [Security] タブをク リ ッ ク して、 [Advanced] をク リ ッ ク します。

e [Add] ボタンを選択して、 委任するユーザー アカウン トの名前を入力し、 [OK] をク リ ッ ク します。

f [Apply to] ド ロップダウン  リ スト で、 [msExchSystemMailbox objects ] を選択します。

g [READ PROPERTY & WRITE PROPERTY] チェッ クボッ クスをオンにします。

h その後、 [OK] ボタンをク リ ッ ク し、 すべてのプロパティ  シート を閉じます。

i AD 複製を待機するか、 強制します。

PowerShell Collector ツールの起動

[PowerShell Collector の起動 ] ツールを起動するには、 以下の手順に従います。

1 [ツール] → [SPI for Exchange] → [Exchange 2007] を展開します。 Microsoft Exchange SPI のツールが

表示されます。

2 [PowerShell Collector の起動 ] ツールをダブルク リ ッ ク します。 ウ ィンド ウにすべての管理ノードが表

示されます。

3 Exchange 管理ノードを選択して、 [起動 ] をク リ ッ ク します。 選択したノードで [PowerShell Collector
の起動 ] ツールが起動します。

このツールを起動する前に、 [XPL 設定フ ァ イルの編集 ] ツールを実行して く ださい。 このツールは、

PowerShell Collector ツールを非エージェン ト  ユーザーと して実行できるよ うにします。

[PowerShell Collector の起動 ] ツールを起動する前に、 管理ノードで [XPL 設定ファイルの編集 ] ツールを

実行します。 このツールは、PowerShell Collector ツールを非エージェン ト  ユーザーと して実行できるよ う

にします。

[PowerShell Collector の起動 ] ツールは出力を返しません。 ツールのステータスは、 [起動中] のままです。

PowerShell Collector が起動したかど うかを確認するには、 ツールの出力を閉じ、 管理ノードのタスク  マ
ネージャを確認して ください。
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[データ  ソースの作成 ] および [DataCollector の登録 ] ツールを実行するには、 以下の手順に従います。

1 [ツール] → [SPI for Exchange] → [Exchange 2007] を展開します。 Microsoft Exchange SPI のツールが

表示されます。

2 [データ  ソースの作成 ] ツールをダブルク リ ッ ク します。 ウ ィンド ウにすべての管理ノードが表示されま

す。
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3 Microsoft Exchange 管理ノードを選択して、 [起動] をク リ ッ ク します。 選択したノードで [データ  ソー

スの作成 ] ツールが起動します。

4 [DataCollector の登録 ] ツールの手順 1 ～ 3 を実行します。
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EXSPI-8X Check Collector Server_jp ポリシーの資格情報の入力

EXSPI-8X Check Collector Server_jp ポ リ シーに、 [PowerShell Collector の起動 ] ツールを起動するユー

ザーと同じ資格情報を入力します。 ユーザーに必要な権限の詳細については、 PowerShell Collector の起動 :
[PowerShell Collector の起動 ] ツールは、 PowerShell Collector を Exchange ノード上で起動します。 を参

照して ください。

資格情報を入力するには、 [ユーザー ] ボタンを選択します。 資格情報を入力し、 ポ リシーを保存します。

ポリシーのカスタマイズ

必要に応じて、 Microsoft Exchange SPI ポ リシーをカスタマイズできます。 ポ リシーをカスタマイズするに

は、 以下の手順に従います。

1 ポ リシーを右ク リ ッ ク し、 [すべてのタスク ]、 [編集 ...] の順に選択します。 

2 [ しきい値レベル ] タブと  [オプシ ョ ン ] タブのいずれかまたは両方をク リ ッ ク してカスタマイズします。

必要に応じて、 必要なしきい値や他のオプシ ョ ンを設定します。
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3 [ポリシーを保存して閉じる ]をク リ ッ ク します。

4 配布したポ リシーをカスタマイズした場合、 カスタマイズしたポ リシーを再配布します。

管理ノードへの Microsoft Exchange SPI ポリシーの配布

Microsoft Exchange サーバー ノードをク ラスタ環境で実行する場合、検出ポ リシーの編集 (38ページ ) の手

順を実行して ください。

1 HPOM コンソールのコンソール ツ リーで、[ポリシー管理 ] → [ポリシー グループ ] → [SPI for Exchange]

→ [ja] → [Exchange 2007] → [Manual Deploy Groups] の順に展開します。

2 [<ポリシー グループ >] を右ク リ ッ ク します。 [すべてのタスク ] → [配布先ノード ...] を選択します。 [ポリ

シーの配布先 ...] ウ ィンド ウが表示され、 すべての管理ノードが一覧表示されます。

以前のバージ ョ ンの Microsoft Exchange SPI ポ リシーのカスタマイズを保持するには、Software Upgrade
Tool Kit 2.0 を使用します。 詳細については、 『HP Operations Smart Plug-in Upgrade Toolkit Windows
User Guide』 を参照してください。

EXSPI pssnapin を読み込んだ PowerShell プロンプ トが管理モードで開かれたままになっている と、 設定

の配布が失敗します。
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3 <ポリシー グループ> を配布する  1 つ以上の Exchange 管理ノードを選択し、 [OK] をク リ ッ ク します。

 <ポリシー グループ> が、 適切なサーバーの役割を持つ選択したノードに配布されます。

4 配布後のポリシーのステータス と して [有効化 ] を選択します。 

ポ リシー グループが関連する役割を持つ管理ノードには、それらのポ リシー グループのみを割り当てます。

たとえば、 管理ノードがエッジ サーバーをホスティングしている場合、 エッジ サーバーのポ リシー グルー

プのみを配布します。
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特定の Exchange サーバーに特定のポリシー グループを配布するには、表 3 でサーバーの役割と配布するポ

リシー グループを参照してください。

表 3　 　サーバーの役割とポリシー グループ

個々のサーバーの役割にかかわらず、 すべての管理ノードに以下のポリシー グループを配布します。

• 検出

[ ポ リ シー管理 ] → [ ポ リ シー グループ ] → [SPI for Exchange] → [ja] → [Exchange 2007] → [Manual

Deploy Groups] → [Mailbox Server]

• 可用性

[ ポ リ シー管理 ] → [ ポ リ シー グループ ] → [SPI for Exchange] → [ja] → [Exchange 2007] → [Manual

Deploy Groups] → [Mailbox Server]

• コレクタ定義

[ ポリ シー管理 ] → [ ポリ シー グループ ] → [SPI for Exchange] →  [ja] → [Exchange 2007] → [Manual

Deploy Groups] → [Collector Definition]

• ExBPA の統合

[ ポ リ シー管理 ] → [ ポ リ シー グループ ] → [SPI for Exchange] → [ja] → [Exchange 2007] → [Manual

Deploy Groups] → [Mailbox Server]

サーバーの役割 ポリシー グループ

メールボッ クス  
サーバー

[ポリシー管理 ] → [ポリシー グループ ] → [SPI for Exchange] 
→ [ja] → [Exchange 2007] → [Manual Deploy Groups] → 
[Mailbox Server]

ハブ ト ランスポート  
サーバー

[ポリシー管理 ] → [ポリシー グループ ] → [SPI for Exchange] 
→ [ja]→ [Exchange 2007] → [Manual Deploy Groups] → 
[Hub Transport Server]

エッジ ト ランスポート  
サーバー

[ポリシー管理 ] → [ポリシー グループ ] → [SPI for Exchange] 
→ [ja] → [Exchange 2007] → [Manual Deploy Groups] → 
[Mailbox Server]

ク ライアン ト  アクセス  
サーバー

[ポリシー管理 ] → [ポリシー グループ ] → [SPI for Exchange] 
→ [ja] → [Exchange 2007] → [Manual Deploy Groups] → 
[Mailbox Server]

ユニファイ ド  
メ ッセージング 
サーバー

[ポリシー管理 ] → [ポリシー グループ ] → [SPI for Exchange] 
→ [ja] → [Exchange 2007] → [Manual Deploy Groups] → 
[Mailbox Server]

EXSPI-8X Check Collector Server_jp ポ リシーを編集し、[PowerShell Collector の起動 ] ツールの実行に必

要な権限と同じ権限で実行されるよ うにします。 詳細については、 ツールの実行 ‐ [デー タ  ソースの作成 ]、
[DataCollector の登録]、 [PowerShell Collector の起動]に記載されている  (PowerShell の起動ツールに関す

る ) 権限を参照してください。
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データのログ記録のシナリオ

Performance Agent をデータ  ス ト ア と して使用する場合、 データ  ソースの作成とデータのログ記録が

Performance Agent でデフォルトで実行されます。 設定は不要です。

データ  ソースを作成し、 データを CODA に記録するには、 Performance Agent のインス トール中に、 以下

の手順を実行します。

1 dsi2ddf フォルダをパス  %OvAgentDir%\Conf に作成します (存在しない場合 )。

2 空のファイル nocoda.opt を作成します。

3 EX2007_DATA 以外のデータ  ソースの名前を入力します。 このデータ  ソースは、 Performance Agent
で作成され、 そこで nocoda.opt ファ イルにデータをログ記録する必要があ り ます。 

データ  ソース  EX2007_DATA は、 CODA で作成され、 そこでデータのログ記録が行われます。 

データ  ス ト ア (CODA) の メ ト リ ッ ク と ポ リ シーのログ記録の詳細については、 『HP Operations Smart
Plug-in for Microsoft Exchange Server オンライン ヘルプ』 を参照してください。

検出の設定のシナリオ

Microsoft Exchange SPI は、 Microsoft Exchange 2007 Server のサービスを検出し、 Microsoft Exchange
環境の管理を支援します。 Microsoft Exchange サービスを検出するには、以下のセクシ ョ ンに示すタスクを

実行します。

検出ポリシーの編集

Microsoft Exchange SPI の検出ポリシーを編集するには、 以下の手順に従います。

1 HPOM コンソールのコンソール ツ リーで、[ポリシー管理 ] → [ポリシー グループ ] → [SPI for Exchange]

→ [ja] → [Exchange 2007] → [Manual Deploy Groups] → [Discovery] の順に展開します。

2 ペインから  [Exchange 2007 Discovery_jp] を右ク リ ッ ク します。

3 [すべてのタスク ] を選択し、 [編集 ] をク リ ッ ク します。 [検出 ] タブが表示され、 必要な資格情報を入力

できるよ うにな り ます。

ク ラスタ  Exchange サーバー ノードでのみ、 以下の手順を実行します。
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4 配布後のポリシーのステータス と して [有効化 ] を選択します。
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5  Exchange Organization Administrator の資格情報を入力し、 [ポリシーを保存して閉じる ] をク リ ッ ク

します。

管理ノードへの検出ポリシーの配布

Exchange 2007 Discovery_jp ポ リシーを Exchange ノードに配布します。 検出ポ リシーを配布するには、以

下の手順に従います。

1 HPOM コンソールのコンソール ツ リーで、[ポリシー管理 ] → [ポリシー グループ ] → [SPI for Exchange]

→ [ja] → [Exchange 2007] → [Manual Deploy Groups] → [Discovery] の順に展開します。

2 ペインから  [Exchange 2007 Discovery_jp] を右ク リ ッ ク します。

3 [すべてのタスク ] を選択し、 [配布先ノード .....] をク リ ッ ク します。 すべての管理ノードが一覧表示され

ます。
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4 検出ポリシーを配布する  Exchange ノードを選択し、 [OK] をク リ ッ ク します。

5 配布後のポリシーのステータス と して [有効化 ] を選択します。
Microsoft Exchange SPI の設定 41



サービス マップの表示

HPOM コンソールを使用してサービス  マップを表示できます。 Microsoft Exchange 2007 の最新のサービ

スを表示するには、 [サービス ] を展開し、 [Applications] をク リ ッ ク します。 右ペインにマップが表示されま

す。
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サービス  マップに、Microsoft Exchange Server 2007 の新し く検出されたサービスが表示されます。 特定の

サービス と  Exchange 管理ノードを表示するには、 階層を展開します。

その他の設定手順

データ収集設定をカスタマイズして、Microsoft Exchange Server 2007 ノードでの Microsoft Exchange SPI
の監視機能を強化できます。 Microsoft Exchange SPI データ  コレクタは、あらかじめ定義されているデータ

収集設定に従って管理ノードを監視します。 

あらかじめ定義されているデータ収集設定を使用して、 管理ノード を監視し ます。 使用する  Microsoft
Exchange SPI データ  コレクタのデフォルトの設定に新しい設定を追加できます。 新しいデータ収集設定を

作成し、 それらを変更するこ とができます。

EXSPI データ  コレクタの機能

あらかじめ設定されているデータ収集設定は、 spimetadata.xml という  XML ファ イルに記述されていま

す。 spimedata.xml フ ァ イルを使用するには、 [Collector Definition] ポ リ シー グループの EXSPI-8X

SPIMetaData Versioning_jp ポ リシーを配布します。 EXSPI データ  コレク タは、spimetadata.xml ファ イ

ルに定義されているデータ収集設定に従います。 このファ イルは、収集で構成されています。 これによって、
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EXSPI データ  コレクタによって収集されるデータが決ま り ます。 データ収集設定には、収集、保存、警告の

完全なワークフローが記述されています。

データ収集設定は、 以下のコンポーネン ト  (要素 ) で構成されます。 

• MetricSet : メ ト リ ッ クは、システムやアプリ ケーシ ョ ンの特定の運用やパフォーマンスの特徴を定義す

る測定値です。 MetricSet は、 関連する メ ト リ ッ クを集めた 1 つのグループです。

• OpCMsg Calls: OpCMsg Call は、 メ ト リ ッ ク値があらかじめ設定された値や値の範囲に一致しない場

合に警告メ ッセージを生成します。

• OpCMon Calls: OpCMon Call は、 Measurement Threshold ポ リシーに収集されたデータを送信しま

す。 Measurement Threshold ポ リシーは、ポ リシー内に定義されているいくつかの上限しきい値または

下限しきい値に照らしてデータをチェッ ク し、 警告をメ ッセージ ブラウザに送信します。

• Data Store: Data Store は、収集されたデータをデータ  ス ト ア (CODA または PA) に保存するために使

用可能な方法を定義します。

各データ収集は、Scheduled Task ポ リシーに関連付けられています。 各収集は、収集 ID という  一意の整数

値に関連付けられます。 収集プロセスを起動するには、 EXSPI データ  コレクタに IP をパラ メータ とする要

求を送信する必要があ り ます。 これは、 コマンド  HP.OV.SPI.ExScheduler -CID <ID> を実行する各収

集の Schedule Task ポ リシーによって実行されます。

Scheduled Task ポ リ シーを管理ノードに配布する と、EXSPI データ  コレクタが以下の詳細情報をデータ収

集設定から取り出します。

• 実行される  cmdlet と、 Resultset から収集される メ ト リ ッ ク  

• 収集されたデータをログ記録するデータ  ス ト アの名前

• 特定のメ ト リ ッ クを渡す監視ポリシーの名前。 このポ リシーがこのメ ト リ ッ ク値のしきい値を実行しま

す。

• メ ト リ ッ クに適用する  spimetadata.xml ファ イルのルール セッ ト。 必要な場合は opcmsg を生成し

ます。

EXSPI 設定ユーティ リテ ィ  ツール

Microsoft Exchange SPI には EXSPI 設定ユーテ ィ リ テ ィ とい う ツールがあ り、 これによって Microsoft
Exchange Server 2007 ノードの spimetadata.xml ファ イルで指定されているデフォル ト のデータ収集

設定を変更した り、 グラフ ィカル ユーザー インターフェイスを通じて新しいデータ収集を追加した りする

こ とができます。 データ収集設定のコンポーネン ト  (MetricSet、OpCMsg Call、OpCMon Call、Data Store)
を追加し、 新し く作成した収集設定を変更して管理ノードを監視するこ とが可能です。 

EXSPI 設定ユーティ リテ ィの使用

EXSPI 設定ユーティ リ ティ  ツールを起動するには、 以下の手順に従います。

1 コンソール ツ リーで [ツール ] → [SPI for Exchange] を展開して、 [Exchange 2007] をダブルク リ ッ ク し

ます。 

2 詳細ペインで、[EXSPI 設定ユーティ リテ ィ ] をダブルク リ ッ ク します。 [サーバーの選択] ダイアログ ボッ

クスが開きます。 

EXSPI データ  コレクタで収集できるのは、 管理ノードで使用可能な cmdlet からのデータのみです。
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3 [OM for Windows Server] オプシ ョ ンを選択して、 [Load] をク リ ッ ク します。 

4 EXSPI 設定ユーティ リ ティ  ツールが起動し、 収集トポロジーが表示されます。

EXSPI 設定ユーティ リテ ィの表示

新しいデータ収集設定を作成するために必要なタスクを実行するには、 EXSPI 設定ユーティ リ テ ィのグラ

フ ィカル ユーザー インターフェイスを使用します。 グラフ ィカル ユーザー インターフェイスは、 以下の要

素で構成されています。 

• メニュー バー

• ツール バー

• 左ペインと右ペイン

Operations Manager for Windows のリモート  コンソールでは、 [Open from Config File Policy] オプシ ョ ン

は使用でき ません。 ローカルの SPIMetaData.xml から設定を編集し、 EXSPI-8X SPIMetaData
Versioning_jp ポ リシーを更新して、 管理ノードに再配布します。 
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EXSPI 設定ユーティ リテ ィのメニューバー

メニュー バーのメニュー オプシ ョ ンを使用して、 収集定義の要素の追加や削除のよ う な作業を実施するこ

とができます。 また、 [Preview] メニュー オプシ ョ ンを使用して、 すべての要素のプレビューを (XML マー

クアップ形式で ) 見るこ と もできます。 

表 4　 　 EXSPI 設定ユーティ リテ ィのメニューバー

メニュー オプシ ョ ン 説明

File Save 行ったあらゆる変更を保存します。

Save as 更新された spimetadata.xml 
ファ イルを別の場所や別の名前で

保存するこ とができます。

Reload/ Cancel All 
Changes

ユーティ リ ティ を再ロード し、 保

存されていない変更をキャンセル

します。 

Exit PowerShell 収集設定ユーティ リ

ティを終了します。 

Edit Delete Selected 
Collection

選択した収集設定またはコンポー

ネン ト をこのメニューから削除し

ます。 

Insert Add New MetricSet 既存の MetricSet のリ ス トに新規 
MetricSet を 1 つ追加します。 

Add New Metric 特定の MetricSet 内の既存のメ ト

リ ッ クの リ ス トに新規メ ト リ ッ ク

を 1 つ追加します。 このオプシ ョ

ンは MetricSet を 1 つ選択したと

きのみ有効になり ます。

Add New Collection 既存の収集のリ ス トに新規収集を 
1 つ追加します。 

Add New DataStore 既存の DataStore のリ ス トに新

規 DataStore を 1 つ追加します。 

Add New OpCMon 
Call

既存の OpCMon 呼び出しのリ ス

トに新規 OpCMon 呼び出しを 1 
つ追加します。 

Add New OpCMsg 
Call

既存の OpCMsg 呼び出しのリ ス

トに新規 OpCMsg 呼び出しを 1 
つ追加します。
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EXSPI 設定ユーティ リテ ィのツールバー

ツールバーを使用して、 MetricSet、 DataStore、 OpCMsg Calls、 および OpCMon Callsのよ うな収集の要

素を追加するこ とができます。 

表 5　 　 EXSPI 設定ユーティ リテ ィのツールバー

アイコン ツール名

Add MetricSet

Add DataStore

Add OpCMsg Call

Add OpCMon Call
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EXSPI 設定ユーティ リテ ィのペイン

左ペインには、既存のすべてのメ ト リ ッ ク、MetricSet、収集、DataStore、OpCMsg Call、および OpCMon
Call が、 ツ リーのよ うな構造でリ ス ト されます。 左ペインの機能を利用して、 特定の収集要素を見つけるこ

とができます。 右ペインでは、 すべての収集要素に対してプロパティや設定を表示した り変更したりするイ

ンタフェースを提供します。 

収集設定の保存

更新した収集設定の保存方法は 2 通りあ り ます。

• [File] → [Save]

• [File] → [Save]

EXSPI 設定ユーテ ィ リ テ ィ を変更するには、 変更したデータ収集メ カニズムを適用する管理ノードに

EXSPI-8X SPIMetaData Versioning_jp ポ リ シーを配布し ます。 以前のバージ ョ ンの EXSPI-8X
SPIMetaData Versioning_jp ポ リシーに戻しても、 GUI には最新バージ ョ ンが表示されます。
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[File] → [Save] オプシ ョ ン

以下の場所からファイルを開きます。

• [OM for Windows] オプシ ョ ン : EXSPI-8x SPIMetadata Versioning_jp ポ リシーから設定が読み取られ

ます。 更新した設定を保存する と、 データがポ リ シーに書き込まれます。 これで、 ポ リ シーのバージ ョ

ンが更新されします。 

この設定をノードで使用できるよ うにするには、 ポ リシーを配布します。

• ローカル ディ スク : ローカル ディ スクからファ イルを保存する と、最新のファイルによって以前のファ

イルが上書きされるため、 バージ ョ ンは保持されません。

[File] → [Save As] オプシ ョ ン

[Save]、 [Save As] をク リ ッ クする と、 ローカル ディ スクのでの場所にかかわらず、 ファ イルが 保存されま

す。 ただし、 [Save As] オプシ ョ ンで保存できるのは、 ローカル コピーのみです。 

収集データの追加

EXSPI 設定ユーティ リ ティ  ツールを使用して、 以下のコンポーネン ト を追加できます。

• MetricSet

• OpCMsg Call

• OpCMon Call

• DataStore

• Collection

MetricSet の追加

MetricSet は、 関連する メ ト リ ッ クを集めた 1 つのグループです。 Microsoft Exchange SPI は、 Microsoft
Exchange Server 2007 の健全性、 可用性、 パフォーマンスを監視するためのさまざまなメ ト リ ッ クを収集

します。 

各 MetricSet は PowerShell コマンドを実行できます。 PowerShell コマンドは 1 つの cmdlet またはパイプ

ライン cmdlet のいずれかです。 以下の cmdlet のいずれかまたはすべてを使用できます。

• デフォルトの PowerShell cmdlet

• Microsoft Exchange cmdlet

• EXSPI 内部 cmdlet

• ユーザー作成の cmdlet (追加 cmdlet の使用を参照 )

新しい MetricSet を追加するには、 以下の手順に従います。 

1 左ペインで [Collection Components] から  [MetricSet] を右ク リ ッ ク して [Add New MetricSet] をク リ ッ

クするか、 メ ニュー バーから  [Insert] → [Add New MetricSet] を ク リ ッ ク し ます。 新しい MetricSet
(MetricSet 名 : New MetricSet) が MetricSet リ ス トに表示されます。 

ファ イルを保存するたびに新しいバージ ョ ンが作成されるので、頻繁に保存してファイルのバージ ョ ンが増

えるこ とのないよ うに注意して ください。

Do

デフォルトの MetricSet と  DataStore のいずれかまたは両方を変更しないでください。 ただし、新し く追加

した MetricSet、 DataStore、 OpCMsg Call、 OpCMon Call は変更できます。
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2 右ペインで、 MetricSet の名前を指定します。 たとえば、 GetMailBox と入力します。 ド ロ ップダウン

リ ス トから  PowerShell コマンドを選択します。 

このリ ス トには、 Microsoft Exchange Management PowerShell で使用可能なデフォルトの cmdlet が
あ り ます。

3 [Apply Changes] をク リ ッ ク します。

PowerShell コマン ド の ド ロ ップダウ ン オプシ ョ ンでは、 1 つのコマン ド のみ使用でき ます。 複数の

PowerShell コマンド  (パイプライン コマンド ) の場合、 必要なコマンドを手動で入力する必要があ り ます。
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4 [File]→[Save] をク リ ッ ク します。 左ペインに、他の MetricSet と 共に追加した MetricSet (GetMailBox)
が表示されます。 

MetricSet GetMailBoxDetails ( メールボッ クス詳細の収集に必要 ) の場合、cmdlet は Get-Mailbox です。 ま
たは、 フ ィルタを追加してシステム メールボッ ク ス詳細をログ記録しない場合、 "Get-Mailbox | where
{$_.DisplayName -notlike "SystemMailbox*" }" も可能です。

新しい MetricSet を追加する と、 EXSPI 設定ユーティ リ ティが MetricSet に新しいメ ト リ ッ ク  テンプレー

ト を追加します。 新しいメ ト リ ッ クを作成し、 新し く作成された MetricSet に追加するこ とができます。

メ ト リ ッ クの追加

新しい MetricSet を追加した後、 メ ト リ ッ クを追加するか、 MetricSet で指定した PowerShell コマンドの

Resultset から メ ト リ ッ クを選択する必要があ り ます。 コマンドが 1 つの cmdlet である場合、 ド ロ ップダウ

ン リ ス トから メ ト リ ッ クを選択します。 コマンドがパイプライン コマンド  (複数の cmdlet) である場合、 そ

れらのコマンドを入力します。 その後、パイプラインの最後の cmdlet の Resultset から各メ ト リ ッ ク名を入

力します。

新しいメ ト リ ッ クを追加するには、 以下の手順に従います。 

1 左ペインで、 [Collection Components] から  [MetricSets] を展開します。

2 MetricSet (例 : [GetMailbox]) を右ク リ ッ ク して [Add New Metric] をク リ ッ クするか、 メニュー バーか

ら  [Insert] → [Add New Metric] をク リ ッ ク します。 
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3 新しいメ ト リ ッ ク  ( メ ト リ ッ ク名 : New Metric) が選択した MetricSet の下のメ ト リ ッ ク  リ ス トに表示

され、 右ペインで以下のオプシ ョ ンを (表に示すとおり ) 入力できるよ うになり ます。 

オプシ ョ ン 説明

Metric Name 使用可能なメ ト リ ッ クのド ロ ップダウン 
リ ス トから メ ト リ ッ ク名を選択するか、 ド

ロ ップダウン リ ス トに表示されていない

場合は必要なメ ト リ ッ ク名を入力します。 
たとえば、 NextHopDomain と入力します。

Metric 
Description

メ ト リ ッ クの説明を入力します。 たとえ

ば、 RulesQuota と入力します。 

Metric Data 
Type 

メ ト リ ッ クを選択する と、 デフォルトで適

切なデータ  タイプが表示されます。 デフォ

ルトの設定 (RulesQuota) を変更しないで

ください。 ただし、 メ ト リ ッ クを入力した

場合は、 必要なメ ト リ ッ クのデータ  タイ

プも入力する必要があ り ます。
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Category バイ ト /キロバイ ト単位のメ ト リ ッ クの場

合のみ、 カテゴ リ を指定する必要があ り ま

す。 たとえば、 MetricSet GetMailbox の
場合、 メ ト リ ッ ク 「RulesQuota」 は値を

キロ  バイ ト  (KB) 単位で返します。 した

がって、 選択するカテゴ リはキロ  バイ ト

です。

Scale メ ト リ ッ ク値を選択した単位に変換するた

めに、 乗率を指定します。 たとえば、 メ ト

リ ッ ク値がキロ  バイ ト単位であ り、 バイ

ト単位でメ ト リ ッ クを収集したい場合、 こ

のフ ィールドに 16 (例 ) と入力します。 こ
のオプシ ョ ンは、 バイ トやキロ  バイ ト単

位の値を表すメ ト リ ッ クに有用です。

Suffix 取り除きたいメ ト リ ッ ク値の要素を指定し

ます。 たとえば、 メ ト リ ッ ク値に (1200B 
のよ うに ) 単位 「B」 が付いている場合、

[Suffix] テキス ト  ボッ クス内に 「B」 をタ

イプ入力するこ とによ り、 メ ト リ ッ ク値か

ら 「B」 を取り除く こ とができます。 

このオプシ ョ ンは、 メモ リ  サイズをバイ

ト単位で示すメ ト リ ッ クに有用です。 バイ

ト /キロバイ ト を返す Microsoft Exchange 
cmdlet のメ ト リ ッ クの多くには、 B/KB の
サフ ィ ッ クスが付いています。 たとえば、

「RulesQuota」 では KB です。 計算にメ ト

リ ッ クを使用するには、 サフ ィ ッ クスを削

除する必要があ り ます。 こ こでサフ ィ ッ ク

スを処理するこ とで、 コレクタが使用する

前にメ ト リ ッ クからサフ ィ ッ クスを削除し

ます。 

各メ ト リ ッ クに対してサフ ィ ッ クスを 1 つ
指定します。

オプシ ョ ン 説明
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4 [Apply Changes] をク リ ッ ク してメ ト リ ッ クを保存します。 MetricSet GetMailbox に追加したメ ト リ ッ

ク  RulesQuota が表示されます。 

5 必要に応じて、 他のメ ト リ ッ クを追加します。
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OpCMsg Call の追加

メ ト リ ッ ク値が設定されたしきい値を超える と、 HPOM メ ッセージ ブラウザで警告メ ッセージを受信する

こ とができます。 EXSPI データ  コレクタ設定によ り、 OpCMsg Call を通じて警告を生成するための特定の

MetricSet のメ ト リ ッ クに条件を指定できます。  

OpCMsg 呼び出しは収集定義の要素で、 以下の情報を含みます。 

• メ ト リ ッ クのしきい値 (または値の範囲 )

• メ ト リ ッ クが必要な値に一致しないか値の範囲を超えた場合に送信する警告メ ッセージ

• メ ト リ ッ クが制限値に一致しない場合のイベン トの重要度レベル (重要警戒域、 警戒域、 正常域、 注意

域など )

メ ト リ ッ クに警告ルールを適用できるのは、 1 つ の MetricSet のみです。
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新しい OpcMsg Call を追加するには、 以下の手順に従います。

1 左ペインで [Collection Components] から  [OpCMsg Calls] を右ク リ ッ ク して [Add New OpCMsg Call]

をク リ ッ クするか、 メニュー バーから  [Insert] → [Add New OpCMsg Call] をク リ ッ ク します。 左ペイン

のリ ス トに新しい OpCMsg Add New OpCMsg Call が表示されます。

2 右ペインで、 以下のオプシ ョ ンを (表に示すとおり ) 入力します。 

オプシ ョ ン 説明

OpCMsg Call   
Set Name

適切な名前をタイプ入力します。 

Application 影響のあるアプリ ケーシ ョ ンの適切な名前

を入力します。 [ メ ッセージのプロパティ ] 
ダイアログ ボッ クスを開く と、 HPOM 
メ ッセージ ブラウザでこのテキス ト を表

示するこ とができます。 このフ ィールドは

空白のままでも構いません。 

Object 影響のあるアプリ ケーシ ョ ンのオブジェク

トの適切な名前を入力します。 [ メ ッセー

ジのプロパティ ] ダイアログ ボッ クスを開

く と、 HPOM メ ッセージ ブラウザでこの

テキス ト を表示するこ とができます。 この

フ ィールドは空白のままでも構いません。

Severity イベン トの重要度レベルを選択します。 

Message Text 生成したいメ ッセージをタイプ入力します。 

MetricSet Ref リ ス トから利用可能な MetricSet を 1 つ選

択します。 

Metric Ref リ ス トから利用可能なメ ト リ ッ クを 1 つ選

択します。 

Select 
Arithmetic 
Operator

リ ス トから利用可能な算術演算子を 1 つ選

択します。 

Select Logical 
Operator to 
combine with 
Previous Rule

こ のフィ ールド は、 選択したメ ト リ ッ ク

に対して  2 個以上の制限値または条件を

選択した場合のみ有効になり ます。 利用可

能な算術演算子をベースに作成したルー

ルを結合するために AND または OR を選

択します。

Value to 
compare

選択したメ ト リ ッ クの制限値 ( しきい値 ) 
を選択します。 
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3 [Add] をク リ ッ ク し、 ルールを追加します。

4 [Apply Changes] をク リ ッ ク して OpCMsg Call を保存します。 追加した OpCMsg Call である  GetQueue
が他の OpCMsg Call と 共に表示されます。 
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OpCMon Call の追加

OpCMon Call は、 Measurement Threshold ポ リ シーを通じて メ ト リ ッ ク  データに制限値を設定します。

Microsoft Exchange SPI は、Measurement Threshold ポ リシーから メ ッセージ テキス トや重要度のよ うな

詳細情報を取り出します。 

新しい OpCMon Call を追加するには、 以下の手順に従います。

1 左ペインで [Collection Components] から  [OpCMon Calls] を右ク リ ッ ク して [Add New OpCMon Call]

をク リ ッ クするか、 メニュー バーから  [Insert] → [Add New OpCMon Call] をク リ ッ ク します。左ペイン

のリ ス トに、 新しい OpCMon Call が表示されます。

2 右ペインで、 以下のオプシ ョ ンを (表に示すとおり ) 入力します。 

OpCMon 呼び出しは数値のメ ト リ ッ ク値に対してのみ使用できます。

オプシ ョ ン 説明

Name OpCMon 呼び出しの適切な名前をタイプ

入力します。 

MetricSet Ref 既存の MetricSet を 1 つ選択します。 

Metric Ref OpCMon 呼び出しを設定したいメ ト リ ッ

クの名前を選択します。 

Measurement 
Threshold Policy 
name

この OpCMon Call を関連付ける  
Measurement Threshold ポ リシーの名前

を入力します。
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3 [Apply Changes] をク リ ッ ク して OpCMon Call を保存します。 追加した OpCMon Call である

 TransportQueueCount が、 他の OpCMon Call と共に表示されます。

DataStore の追加

DataStore は、メ ト リ ッ ク  データの保存方法を定義します。 Microsoft Exchange SPI がコレクタを使用して

メ ト リ ッ ク  データ を収集した後、 収集されたデータ を HP Operations エージェン ト のデータ  ス ト ア

(CODA) または HP Performance Agent 内 (HPOM 環境にインス トール済みの場合 ) に保存するこ とができ

ます。 

DataStore の新規追加手順

1 左ペインで [Collection Components] から  [DataStores] を右ク リ ッ ク して [Add New DataStore] をク

リ ッ クするか、 メニュー バーから  [Insert] → [Add New DataStore] をク リ ッ ク します。 左ペインのリ ス

トに新しい DataStore が表示されます。

2 右ペインで、 以下のオプシ ョ ンを (表に示すとおり ) 入力します。

オプシ ョ ン 説明

Name 適切な DataStore の名前をタイプ入力し

ます。 

Capacity DataStore の行数をタイプ入力します。 

Data Source 「EX2007_DATA」 と タイプ入力します。 
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3 [Select MetricSet reference] ド ロ ップダウン リ ス トから適切な MetricSet を選択します。

4 [Select Metric reference] ド ロ ップダウン リ ス トから、 1 つ以上の適切なメ ト リ ッ クを選択します。

5 [Select Data column] ボッ ク ス内に、DataStore が選択したメ ト リ ッ ク を保存するデータ列の名前を入力

します。 2 個以上のメ ト リ ッ ク を追加したい場合は、 このフィ ールド は空白のままにしないでく ださい。 

6 [Add] をク リ ッ ク します。 追加できる  MetricSet は 1 つのみです。メ ト リ ッ クは複数追加できますが、す

べてのメ ト リ ッ クが同じ  MetricSet に属している必要があ り ます。

7 [Apply Changes] をク リ ッ ク して DataStore を保存します。 追加した DataStore である  QueueInfo が
他の DataStore と共に表示されます。

 

Data Table 「EX2007_<テーブル名>」 (<テーブル名> 
は適切なテーブルの名前 ) と入力します。

Index By 毎日、 毎週、 毎月のスケジュールのイン

デッ クスを設定します。 

Roll By データをデータ  ス ト アからフラ ッシュ  ア
ウ トする時間間隔をタイプ入力します。 
「DAY」、 「WEEK」、 または 「MONTH」

を指定するこ とができます。 1 か月を超え

てデータをデータ  ス ト アに保存しておく

こ とはできません。 

オプシ ョ ン 説明
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新しい DataStore を作成した後、 既存の収集設定に追加する必要があ り ます。 収集設定を追加するには、 収

集設定の追加を参照して ください。 新し く作成した DataStore を既存の収集設定に追加した後は、 以下の手

順を実行します。

1 新し く作成した DataStore を選択します。

2 右ペインで、 [Generate SPEC] をク リ ッ ク します。 [Spec File Generator] ダイアログ ボッ クスが開きま

す。

3 [Spec File Generator] ダイアログ ボッ クスで、 [Table Label] テキス ト  ボッ クス内に適切なラベル名を

タイプ入力し、 [Create] をク リ ッ ク します。 SPEC ファ イルの詳細が [Preview of the SPEC File] セク

シ ョ ンに表示されます。

4 [Save] をク リ ッ ク します。 SPEC ファ イルの作成成功確認のポップアップ ボッ クスが開きます。

5 [Spec File Generator] ダイアログ ボッ クスを閉じます。

収集設定の追加

収集はメ ト リ ッ ク  データ収集の完全なメカニズムを定義します。 コレク タは、メ ト リ ッ ク  データを収集して

データ  ス ト アに保存するか、しきい値違反があった場合は HPOM メ ッセージ ブラウザにメ ッセージを送信

します。 収集設定は、 合わさって MetricSet の収集メカニズムの完全なライフサイ クルを説明するすべての

要素で構成されます。 

新しい収集設定を追加するには、 以下の手順に従います。

1 左ペインで、 [Collection Configurations] を右ク リ ッ ク して [Add New Collection] をク リ ッ クするか、

[Insert] → [Add New Collection] をク リ ッ ク します。 新しい収集に MetricSet を追加するウ ィ ン ド ウが

表示されます。

2 [Component Name] ボッ クスのド ロ ップダウン メニュー リ ス トから  MetricSet を選択します。

PowerShell 収集設定ユーティ リ テ ィ を使用して新しい DataStore を作成して SPEC ファ イルを生成する

場合、 管理ノードのインス トルメンテーシ ョ ン ディ レク ト リで SPEC ファ イルが使用可能になっているこ

とを確認します。 そのためには、 Microsoft Exchange SPI の [Instrumentation Category] フォルダ

に SPEC ファ イルを保存します。 HPOM サーバーの

 %ovsharedir%\Instrumentation\Categories\Exchange2k7_Core に SPEC ファ イルを保存しま

す。 次に、 ノードに Exchange2k7_Core カテゴ リ を配布し ます。 この後、 そのノード上で [Create Data
Source] ツールを起動してデータ  ソースを追加します。 EXSPI-8X SPIMetaData Versioning_jp ポ リ シー

を配布する前に、 ノード上で [データ  ソースの作成 ] ツールを起動します。
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たとえば、 収集に MetricSet が追加されます。

3 この収集に OpCMsg Call を追加するため、 右ペインで [Add OpCMsg] をク リ ッ ク します。 新しい収集

に OpCMsg Call を追加するウ ィンド ウが表示されます。

4 [Component Name] ボッ クスのド ロ ップダウン リ ス トから  OpCMsg Call を選択し、 [Add] をク リ ッ ク

します。 収集に OpCMsg Call が追加されます。
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5 この収集に OpCMon Call を追加するため、 右ペインで [OpCMon の追加 ] をク リ ッ ク します。 新しい収

集に OpCMon Call を追加するウ ィンド ウが表示されます。

6 [Component Name] ボッ クスのド ロ ップダウン リ ス トから  OpCMon Call を選択し、 [Add] をク リ ッ ク

します。 収集に OpCMon Call が追加されます。
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7 DataStore を追加するため、右ペインで [DataStore の追加 ] をク リ ッ ク します。 新しい収集に DataStore
を追加するウ ィンド ウが表示されます。

8 [Component Name] ボッ クスのド ロ ップダウン リ ス トから適切な DataStore を選択し、[Add] をク リ ッ

ク します。 収集に DataStore が追加されます。
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9 右ペインで、 [Collection Configuration] テキス ト  ボッ クス内に適切な名前をタイプ入力します。

10 [File]→[Save] をク リ ッ ク します。 新しい収集設定  がデフォルト の設定 と 共に表示されます。

11 [Schedule Task Policy Command] テキス ト  ボッ クスに表示されるコマンドを記録してください。

12 新しい収集設定を追加した後、 以下のタスクを実行する必要があ り ます。

a  新しい Scheduled Task ポ リシーを作成します。

b 新し く作成した Scheduled Task ポ リシーで、 記録したコマンドを指定します。 

変更したデータ収集メカニズムを利用するには、 対象のノードに新たに作成した Scheduled Task ポ リシー

(EXSPI-8X SPIMetaData Versioning_jp ポ リシーと共に ) を配布する必要があ り ます。
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収集の変更

EXSPI 設定ユーティ リ ティ  ツールを使用して、 新し く追加した収集の設定を変更できます。

• MetricSet

• OpCMsg Call

• OpCMon Call

• DataStore

• Collection configuration

MetricSet の変更

MetricSet を変更するには、 以下の手順に従います。

1 変更する必要がある  MetricSet (例: GetQueue) をク リ ッ ク します。 右ペインに MetricSet の詳細が表示

されます。

2 右ペインで、 以下の 1 つ以上のオプシ ョ ンを (表に示すとおり ) 変更します。

3 [Apply Changes] をク リ ッ ク して変更内容を保存します。

EXSPI 設定ユーティ リ ティにあるデフォルトの MetricSet は削除しないでください。 EXSPI 設定ユーティ

リ テ ィ に追加し た MetricSet を削除するには、 左ペイ ンでその MetricSet を右ク リ ッ ク し て [Delete

Selected MetricSet] をク リ ッ ク します。 

メ ト リ ッ クの変更

既存のメ ト リ ッ クを変更するには、 以下の手順に従います。 

1 左ペインで、 変更したいメ ト リ ッ クをク リ ッ ク します。 

Do

デフォルトの MetricSet と  DataStore のいずれか、 または両方を変更しないでください。 

オプシ ョ ン 説明

MetricSet 
Name 

適切な名前に変更します。 

Powershell 
Command

既存のコマンドのリ ス トからコマンドを 1 
つ選択します。 

PowerShell コマンドを変更する と、 以前に追加したすべてのメ ト リ ッ クが削除されます。

既存 (デフォルト ) の MetricSet のメ ト リ ッ クの順序は変更しないでください。 変更できるのは、 EXSPI 設
定ユーティ リ ティに追加した MetricSet のメ ト リ ッ クの順序のみです。
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2 右ペインで、 以下の 1 つ以上のオプシ ョ ンを (表に示すとおり ) 変更します。 

3 [Apply Changes] をク リ ッ ク します。

EXSPI 設定ユーティ リ テ ィにあるデフォル トのメ ト リ ッ クは削除しないでください。 EXSPI 設定ユーティ

リ ティに追加したメ ト リ ッ クを削除するには、 左ペインでそのメ ト リ ッ クを右ク リ ッ ク して [Remove this..]

をク リ ッ ク します。

4 [Apply Changes] をク リ ッ ク します。

5 [File]→ [Save] をク リ ッ ク します。

OpCMsg Call の変更

既存の OpcMsg Call を変更するには、 以下の手順に従います。

1 左ペインで [Collection Components] を展開し、 変更する  OpCMsg Call をク リ ッ ク します。 

2 右ペインで、 以下の 1 つ以上のオプシ ョ ンを (表に示すとおり ) 変更します。 

オプシ ョ ン 説明

Metric Name 既存のメ ト リ ッ クの リ ス トから メ ト リ ッ ク

名を 1 つ選択します。 

Metric 
Description

メ ト リ ッ クの説明をタイプ入力します。 

Metric Data 
Type 

メ ト リ ッ クを選択する と、 デフォルトで適

切なデータ  タイプが表示されます。 デフォ

ルトの設定を変更しないでください。 

Category このオプシ ョ ンを変更してメ ト リ ッ クの計

測単位を指定します。 

Scale メ ト リ ッ ク値を選択した単位に変換するた

めに、 乗率を指定します。 たとえば、 メ ト

リ ッ ク値がキロ  バイ ト単位であ り、 バイ

ト単位でメ ト リ ッ クを収集したい場合、 こ

のフ ィールドに 1024 を指定します。

Suffix 取り除きたいメ ト リ ッ ク値の要素を指定し

ます。 たとえば、 メ ト リ ッ ク値に (1200B 
のよ うに ) 単位 「B」 が付いている場合、

[Suffix] テキス ト  ボッ クス内に 「B」 をタ

イプ入力するこ とによ り、 メ ト リ ッ ク値か

ら 「B」 を取り除く こ とができます。 

オプシ ョ ン 説明

OpCMsg Call   
Set Name

適切な名前をタイプ入力します。 
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3 [Apply Changes] をク リ ッ ク します。

既存の OpCMsg Call を削除するには、 左ペイ ンでその OpCMsg Call を右ク リ ッ ク して [Remove from

Collection] をク リ ッ ク します。

既存のルールの編集

OpCMsg Call の既存のルールを編集できます。 ルールを編集するには、 以下の手順に従います。

1 [Edit] をク リ ッ ク します。 

2 [Update Rule] セクシ ョ ンで、 以下の 1 つ以上のオプシ ョ ンを変更します。

― メ ト リ ッ ク参照

― 算術演算子

既存のルールを削除するには、[Available Rules] ボッ クスでそのルールを選択して  [Delete] をク リ ッ ク します。

Application 必要に応じて、 影響のあるアプリ ケーシ ョ

ンの名前を変更します。 [ メ ッセージのプロ

パティ ] ダイアログ ボッ クスを開く と、

HPOM メ ッセージ ブラウザでこのテキス

ト を表示するこ とができます。 このフ ィー

ルドは空白のままでも構いません。 

Object 必要に応じて、 影響のあるアプリ ケーシ ョ

ンのオブジェク トの名前を変更します。

 [ メ ッセージのプロパティ ] ダイアログ 
ボッ クスを開く と、 HPOM メ ッセージ ブ
ラウザでこのテキス ト を表示するこ とがで

きます。 このフ ィールドは空白のままでも

構いません。

Severity イベン トの重要度レベルを選択します。 

Message Text 生成したいメ ッセージをタイプ入力します。 

MetricSet Ref リ ス トから利用可能な MetricSet を 1 つ選

択します。 

Metric Ref リ ス トから利用可能なメ ト リ ッ クを 1 つ選

択します。 

Select 
Arithmetic 
Operator 

リ ス トから利用可能な算術演算子を 1 つ選

択します。 

Select Logical 
Operator to 
combine with 
Previous Rule 

このフィ ールド は、 選択したメ ト リ ッ クに

対して  2 個以上の制限値または条件を選択

した場合のみ有効になり ます。 利用可能な算

術演算子をベースに作成したルールを結合

するために AND または OR を選択します。

Value to 
compare

選択したメ ト リ ッ クの制限値 ( しきい値 ) を
選択します。 

オプシ ョ ン 説明
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OpCMon Call の変更

既存の OpCMon Call を変更するには、 以下の手順に従います。

1 左ペインで、 変更したい OpCMon 呼び出しをク リ ッ ク します。

2 右ペインで、 以下の 1 つ以上のオプシ ョ ンを (表に示すとおり ) 変更します。 

3 [Measurement Threshold ポ リシー名 ] テキス ト  ボッ クス内に、 この OpCMon 呼び出しを関連付けた

い Measurement Threshold ポ リシーの名前をタイプ入力します。

4 [Apply Changes] をク リ ッ ク します。

5 既存の OpCMon Call を削除するには、 左ペインでその OpCMon Call を右ク リ ッ ク して [Remove from

Collection] をク リ ッ ク します。

DataStore の変更

既存の DataStore の変更手順

1 左ペインで、 変更したい DataStore をク リ ッ ク します。

2 右ペインで、 以下の 1 つ以上のオプシ ョ ンを (表に示すとおり ) 変更します。

3 [Select MetricSet Reference] ド ロ ップダウン リ ス トから  MetricSet を 1 つ選択します。

4 [Select Metric Reference] ド ロ ップダウン リ ス トから  メ ト リ ッ クを 1 つ選択します。

オプシ ョ ン 説明

Name OpCMon 呼び出しの適切な名前をタイプ

入力します。 

Metric Ref OpCMon 呼び出しを設定したいメ ト リ ッ

クの名前を選択します。 

オプシ ョ ン 説明

Name 適切な DataStore の名前をタイプ入力し

ます。 

Capacity DataStore の行数をタイプ入力します。 

Data Source 「EX2007_DATA」 と タイプ入力します。 

Data Table 「EX2007_<テーブル名>」 (<テーブル名> 
は適切なテーブルの名前 ) と入力します。

Index By 「DAY」 と タイプ入力します。 

Roll By データをデータ  ス ト アからフラ ッシュ  ア
ウ トする時間間隔をタイプ入力します。 
「DAY」、 「WEEK」、 または 「MONTH」

を指定するこ とができます。 1 か月を超え

てデータをデータ  ス ト アに保存しておく

こ とはできません。 
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5 [Select Data Column Reference] ボッ クスに、 DataStore が選択したメ ト リ ッ クを保存するデータ列の

名前を入力します。 

複数のメ ト リ ッ クを追加する場合は、 このフ ィールドは空白のままにしないでください。

6 [Add] をク リ ッ ク します。 複数の MetricSet を追加するこ とはできません。 ただし、 MetricSet にメ ト

リ ッ クを追加するこ とは可能です。 

7 新しい MetricSet および新しいメ ト リ ッ クをこの DataStore に追加するには、 [Add Reference] セク

シ ョ ンで、 新しい MetricSet と メ ト リ ッ クを選択し、 [Add] をク リ ッ ク します。 

8 既存の MetricSet およびメ ト リ ッ ク をこの DataStore から削除するには、[Available Metric References]
リ ス トからエン ト リ を 1 つ選択して [Delete] をク リ ッ ク します。

9 [Apply Changes] をク リ ッ ク します。

SPEC ファイルの再生成

既存の DataStore を変更した後に、SPEC ファ イルを生成しなおす必要があ り ます。 変更した DataStore の
SPEC ファ イルを生成しなおすには、 以下の手順に従います。

1 変更した DataStore を選択します。

2 右ペインで、 [Generate SPEC] をク リ ッ ク します。 [Spec File Generator] ダイアログ  ボッ クスが開きます。

3 [Spec File Generator] ダイアログ ボッ クスで、 [Table Label] テキス ト  ボッ クス内に適切なラベル名を

タイプ入力し、 [Create] をク リ ッ ク します。 SPEC ファ イルの詳細が [Preview of the SPEC File] セク

シ ョ ンに表示されます。

4 [Save] をク リ ッ ク します。 SPEC ファ イルの作成成功確認のポップアップ ボッ クスが開きます。

5 [Spec File Generato] ダイアログ ボッ クスを閉じます。

EXSPI 設定ユーティ リ ティにあるデフォルトの DataStore は削除しないでください。 EXSPI 設定ユーティ

リ ティに追加した DataStore を削除するには、左ペインでその DataStore を右ク リ ッ ク して [Remove from

Collection] をク リ ッ ク します。 DataStore が既存の収集設定に関連付けられている場合、 ユーティ リ ティは

収集から  DataStore を削除します。 

収集設定の変更

既存の収集設定を変更するには、 以下の手順に従います。 

1 左ペインで、 変更したい収集設定をク リ ッ ク します。

2 右ペインで、変更対象の収集設定ブロッ クまたは編集対象のその他任意のコンポーネン ト  ブロ ッ クを右

ク リ ッ ク します。

3 変更完了後、 [File] → [Save] をク リ ッ ク します。

PowerShell 収集設定ユーティ リ テ ィ を使用して新しい DataStore を作成して SPEC ファ イルを生成する

場合、 管理ノードのインス トルメンテーシ ョ ン ディ レク ト リで SPEC ファ イルが使用可能になっているこ

とを確認します。 そのためには、 Microsoft Exchange SPI の [Instrumentation Category] フォルダ

に SPEC ファ イルを保存します。 HPOM サーバーの

 %ovsharedir%\Instrumentation\Categories\Exchange2k7_Core に SPEC ファ イルを保存しま

す。 次に、 ノードに Exchange2k7_Core カテゴ リ を配布します。 この後、 そのノード上で [データ  ソースの

作成 ] ツールを起動してデータ  ソースを追加します。 EXSPI-8X SPIMetaData Versioning_jp ポ リ シーを

配布する前に、 ノード上で [データ  ソースの作成 ] ツールを起動します。

既存 (デフォルト ) の収集設定は変更しないでください。 追加した収集設定を変更できます。 
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EXSPI 設定ユーティ リ テ ィにあるデフォル トの収集設定は削除しないでください。 EXSPI 設定ユーティ リ

テ ィに追加した収集設定を削除するには、 左ペインでその収集を右ク リ ッ ク して [Remove Collection] をク

リ ッ ク します。 

追加 cmdlet の使用

カスタマイズされた cmdlet を作成し、 作成した cmdlet を使用して管理ノード上のメ ト リ ッ ク  データを監

視できます。 カスタマイズした cmdlet を作成して追加メ ト リ ッ クを返し、 Microsoft Exchange SPI を設定

してこれらの追加メ ト リ ッ クを監視できます。 このタスクを行うには、 以下の手順を実行します。

タスク  1: Microsoft Exchange Server 2007 ノードの特定

追加メ ト リ ッ ク  データを観察するためにカスタマイズした cmdlet を追加する  Microsoft Exchange Server
2007 ノードを特定します。

タスク  2: cmdlet の作成

特定したノード上にカスタマイズされた cmdlet を作成します。

タスク  3: スナップインのインストール

新し く作成した cmdlet のためにカスタマイズされたスナップインを、新しい cmdlet を作成したノードにイ

ンス トールします。

タスク  4: Exspi-exshell.psc1 ファイルの更新

新しいスナップイン情報を使用して Exspi-exshell.psc1 ファ イルを更新するには、以下の手順に従いま

す。

1 テキス ト  エディ タを使用し、 %OvAgentDir%/bin/instrumentation から  Exspi-exshell.psc1
ファ イルを開きます。

2 PSSnapin タグ内に以下の指定を追加します。

<PSSnapIn Name="new_snap-in_name" />

こ こで、 new_snap-in_name は、 新たに追加するスナップインの名前です。

3 ファ イルを保存します。

タスク  5: 新しい cmdlet の新しい収集定義の作成

EXSPI 収集設定ユーティ リ ティを使用し、 新たに追加した cmdlet を使用して新しい収集を作成します。 新
しい収集設定を作成する と きには、Schedule Task Policy Command テキス ト  ボッ クスに表示されるコマン

ドを記録して ください。

タスク  6: 新しい Scheduled Task ポリシーの作成

新しい収集設定を作成した後、 以下の手順を実行します。

1 新しい Scheduled Task ポ リシーを作成します。

2 新し く作成した Scheduled Task ポ リシーで、 タスク 5のコマンドを指定します。

スナップインがインス トールされている管理ノードで、 この変更を実行します。 スナップインがすべての管

理ノードにインス トールされている場合、 管理サーバー自体で Exspi-exshell.psc1 を更新できます。
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タスク  7: ノードへの EXSPI-8X Spimetadata Versioning_jp ポリシーの配布

新しい cmdlet を作成したノードに EXSPI-8X Spimetadata Versioning_jp ポ リシーを配布します。

タスク  8: Scheduled Task ポリシーの配布

新しい cmdlet を作成したノードに、 作成した Scheduled Task ポ リシーを配布します。

Exchange Server クラスタ環境での Microsoft Exchange SPI の設定

Microsoft Exchange Server 2007 はクラスタ環境で使用できます。 この環境では、Exchange Server のフェ

イルオーバー機能によって、中断のない Exchange の可用性が保証されます。 ク ラスタ  ノードに万一障害が

発生した場合、Microsoft Exchange SPI は障害のある ノードからアクティブなノードに監視アクティビティ

を自動で切り替えます。

Microsoft Exchange SPI は XML 設定ファ イル (apminfo.xml および msexchange.apm.xml) を使用す

るこ とで、 Exchange ク ラスタ内の Exchange インスタンスを認識します。 障害が発生した場合、 これらの

XML ファ イルによって HP Operations エージェン トは以下の機能を自動的に実行できます。

• 無効ノードでのインスタンス監視の無効化

• 現在アクティブなノードでのインスタンス監視の有効化

Microsoft Exchange SPI をク ラスタ環境用に設定するには、 以下のタスクを所定の順序で実行します。 

タスク  1: HPOM コンソールへの Exchange クラスタ  ノードの追加

Exchange 環境のク ラスタ  ノードを識別し、 これらのノードを HPOM コンソールに追加します。

ポ リシーの自動配布機能が無効になっている場合、新し く追加したク ラスタ  ノード上で必要なポ リ シーを起

動する必要があ り ます。

検出ポ リ シーを編集し、 特別なユーザー権限で実行できるよ うにします。 検出ポ リ シーの編集を参照して く

ださい。 管理ノードの持つサーバーの役割に応じて、 ポ リ シー グループを配布します。 個々のポ リ シー グ
ループについては、 37ページの表3を参照して ください。

検出ポ リシーは Exchange ク ラスタを検出して、 ク ラスタ  ト ポロジでマップを更新します。 

タスク  2: クラスタ  アプリケーシ ョ ン設定ファイルの生成

ク ラスタ  インスタンス  (Exchange 仮想サーバー ) を記述するための apminfo.xml ファ イルを生成する必

要があ り ます。 そのためには、 ク ラスタ設定ツールを起動します。

1 [ツール] → [SPI for Exchange] → [Exchange 2007] を展開します。
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2 詳細ペインで、[Exchange クラスタ設定 ] をダブルク リ ッ ク します。 [ このツールの起動場所の選択 ] ダイ

アログが開きます。
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3 [起動 ...] をク リ ッ ク します。 [ツールのステータス ] ウ ィンド ウが開き、 [ツールの出力 ] セクシ ョ ンの下

に出力が表示されます。

4 <?xml version=” 1.0” ?> よ り上のコンテンツを削除します。

5 [ツールの出力 ] セクシ ョ ンの下からテキス トの内容を選択して、 テキス ト  エディ タにコピーします。

6 テキス ト を apminfo.xml とい う名前で、ク ラスタ  ノードの %OvAgentDir%\conf\conf\ に保存しま

す。

7 以下のコマンドを使用して、 ノードのエージェン ト を停止および開始します。

opcagt -kill

opcagt -start

apminfo.xml ファイルの例

以下の例では、 aspivm6 は aspivm6 インスタンス  (仮想サーバー ) に対応する  Exchange リ ソース  グルー

プの名前です。

<?xml version="1.0" ?>

<APMClusterConfiguration>

  <Application>

    <Name>msexchange</Name>

    <Instance>

      <Name>ASPIVM6</Name>

apminfo.xml ファ イルをコピーする前に、 %OvAgentDir%\conf\conf\ フォルダがなければ

手作業で作成する必要があ り ます。
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      <Package>aspivm6</Package>

    </Instance>

  </Application>

</APMClusterConfiguration>

図4　 　 Exchange リソース グループの例 

タスク  3: クラスタ対応ポリシーの XML ファイルをコピー

以下の手順を実行します。

1 ノードに SPI for Exchange インス トルメンテーシ ョ ンを配布します。

2 %OvAgentDir%\bin\instrumentation\ の下に、 \conf\ フォルダを作成します。

3 msexchange.apm.xml ファ イルを、 %OvAgentDir%bin\instrumentation\ フォルダから

 %OvAgentDir%bin\instrumentation\conf\ にコピーします。

4 エージェン ト を再起動します。

5 すべての Exchange ノードについて、 ステップ1からステップ4を繰り返します。

フ ェ イルオーバーを処理するため、 EXSPI-8X Exchange Cluster Discovery SysLog_jp ポ リ シーを

Windows Server 2003 ク ラスタ  ノードに、 EXSPI-8X Exchange Cluster Discovery AppLog 2K8 ポ リシー

を Windows Server 2008 ク ラスタ  ノードに配布します。
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ポリシー名の変更のための追加設定

Microsoft Exchange SPI は、 ク ラスタ  ノードに障害が発生した場合はノードのすべてのポ リ シーを無効に

し、 アクティブなク ラスタ  ノードのすべてのポ リシーを有効化します。 無効ノードからアクティブなノード

に動作を切り替える間、 Microsoft Exchange SPI はポリシー情報を msexchange.apm.xml ファ イルから

取得します。 いずれかのポ リシー名を変更 (または新規ポ リシーを追加 ) して、変更したポ リ シーを管理ク ラ

スタ  ノードに配布した場合、変更を msexchange.apm.xml ファ イルにも反映させる必要があ り ます。 変更

したポ リシー情報で msexchange.apm.xml ファ イルを更新するには、 以下の手順に従います。

1 管理サーバーでテキス ト  エディ タを使用して、

%OvShareDir%\Instrumentation\Categories\SPI for Exchange\Windows\6.0\X64 にあ

る  msexchange.apm.xml ファ イルを開きます。

2 変更されたポ リシー名をこのファイル内で編集します。 必要な場合、新規ポリシー名を (Template マー

クアップ内に ) 追加します。

3 管理ノードで、 以下の手順に従います。

a ノードに SPI for Exchange インス トルメンテーシ ョ ンを配布します。

b %OvAgentDir%\bin\instrumentation\ の下に、 \conf\ フォルダを作成します。

c msexchange.apm.xml ファ イルを、 %OvAgentDir%bin\instrumentation\ フォルダから

 %OvAgentDir%bin\instrumentation\conf\ にコピーします。

d エージェン ト を再起動します。

e すべてのノードについて、 ステップaからステップdを繰り返します。

インス トルメ ンテーシ ョ ンを Microsoft Exchange Server 2007 ノードに再配布するこ とについては、 管理

ノードへのインス トルメンテーシ ョ ン カテゴ リの配布を参照してください。

Exchange クラスタ  サービス用のマップ ビュー

Microsoft Exchange SPI では Exchange ク ラスタをマップ ビューに表示します。 マップ ビューはクラスタ

内の各仮想サーバーについて、 ノードを 1 つ作成します。 ク ラスタがサービス マップで正し くモデル化され

ているため、 Microsoft Exchange SPI インス トルメ ンテーシ ョ ン と  Quick Start ポ リ シーはすべての管理

Exchange ク ラスタ  ノードに自動配布されます。

Exchange 仮想サーバーのメ ッセージは、 マップの Exchange 仮想サーバー名の下に表示されます。

Exchange 仮想サーバーの場合、 EXSPI サービス検出ホス ト先階層がクラスタ  コンテナ内に作成されます。

これによって、 メ ッセージをホス ト先階層に送信するこ とができます。 

また、 同じ階層が仮想 ノー ド と し て Exchange 仮想サーバーの下に作成されます。 それぞれの仮想

Exchange サーバーの仮想ノードから対応するク ラスタ  ホス ト先ノードへの依存関係が作成されます。 メ ッ

セージおよびステータスは、 正しい仮想 Exchange サーバーの仮想ノードに伝達されます。
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図5　 　 クラスタ環境でのサービス マップ

フェイルオーバーが発生する と、障害が発生したノードへの依存関係は削除されて、新しいアクティブなノー

ドへの新しい依存関係で置換されます。

フェイルオーバーが発生する と、 フェイルオーバー前に出されたメ ッセージは仮想ノードに伝達されませ

ん。
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第4章 ポリシーの使用
ポ リシーは、 Microsoft Exchange 2007 Server 環境を監視し、ルールとスケジュールの指定に従って実行さ

れます。 Scheduled Task ポ リ シーには、 Microsoft Exchange Server 2007 の状態を解釈するためのルール

が含まれます。 すべてのポ リ シーの詳細については、 『HP Operations Smart Plug-in for Microsoft
Exchange オンライン ヘルプ 』 または 『HP Operations Smart Plug-in for Microsoft Exchange Server オン

ライン ヘルプ』 の PDF を参照して ください。

ポリシー グループとポリシー タイプ

HPOM コンソールの Microsoft Exchange SPI のポ リ シーには、 ポ リシー グループとポ リシー タイプがあ

り ます。

ポリシー グループ

ポ リ シー グループは、 配布方法および検出または監視の対象となる分野に従ってポ リ シーを編成します。

Microsoft Exchange SPI の配布は手動で行います。 Microsoft Exchange SPI の手動で配布されたポ リ シー

を表示するには、 HPOM コンソールのコンソール ツ リーで、 [ポリシー管理] → [ポリシー グループ ] → [SPI

for Exchange] → [ja] → [Exchange 2007] → [Manual Deploy Groups] の順に展開し ます。 Microsoft
Exchange SPI の各サブグループにポ リシーが表示されます。
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Microsoft Exchange SPI ポ リシーのしきい値をカスタマイズできます。 詳細については、ポ リ シーのカスタ

マイズを参照して ください。

ポ リシーをカスタマイズするには、 ポ リシーのカスタマイズ (34ページ ) を参照してください。

Microsoft Exchange SPI には、 Exchange サーバーの役割に応じて以下のポ リシー グループがあ り ます。

• Availability

• Client Access Server

• Collector Definition

• Discovery

• Edge Server

• ExBPA Integration

• Hub Transport Server

• Mailbox Server

• Unified Messaging Server

ポリシー タイプ

タイプ別エージェン ト  ポ リシーは、 タイプに従ってポ リシーを編成します。 Microsoft Exchange SPI には、

以下のポリシー タイプがあ り ます。
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• Service Auto-Discovery

• Scheduled Task

• Measurement Threshold

• Windows Event Log

• Windows Management Interface

• ConfigFile

• Open Message Interface

• LogFile Entry

各ポ リ シー グループおよびポ リ シー タ イプの詳細については、 『HP Operations Smart Plug-in for
Microsoft Exchange オンライン ヘルプ』 または 『HP Operations Smart Plug-in for Microsoft Exchange オ
ンライン ヘルプ』 の PDF を参照してください。 
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第5章 ツールの使用
Microsoft Exchange SPI は、 Microsoft Exchange Server 環境を監視するためにさまざまなツールを使用し

ます。 各ツールの機能の詳細については、 『Exchange SPI のオンライン ヘルプ』 を参照してください。 

Microsoft Exchange ツールの起動

Microsoft Exchange SPI を起動するには、 以下の手順に従います。

1 [ツール] → [SPI for Exchange] → [Exchange 2007] を展開します。 Microsoft Exchange SPI のツールが

表示されます。

2 起動するツールをダブルク リ ッ ク します。 ウ ィンド ウにすべての管理ノードが表示されます。

3 Exchange 管理ノードを選択して、 [起動] をク リ ッ ク します。 選択したノードでツールが起動します。

HP Operations Topology Viewer

HP Operations Topology Viewer では、 ツ リー形式の階層ビュー (左ペイン ) とマップ形式の ト ポロジー

ビュー (右ペイン ) が提供されており、 Exchange 環境を迅速に把握するこ とができます。 左ペインには、 組

織 /管理グループ /Microsoft Exchange サーバー / コネクタ /ルーティング グループ コンポーネン トが表示さ

れ、 右ペインには、 サーバー /ルーティング グループ / コネクタ  リ ンク /接続がマップ形式でグラフ ィカルに

表示されます。 

HP Operations Topology Viewer を起動してド メ イン コン ト ローラのアクセス情報を入力する と、ド メ イン

コン ト ローラ と  Microsoft Exchange サーバーからデータが収集されます。 この情報からマップが作成され、

サーバー、 コネクタ、 およびルーティング グループが表示されます。 

ト ポロジー ビューア ウ ィンド ウの右ペインでは、 ルーティング グループ コネク タ、 外部 メール コネクタ

が初期表示されます。 [表示] → [プロパテ ィ ...]  を選択する と、 サーバーのラベルを表示したり、 表示を変更

したりするこ とができます。 [プロパティ ] ページには、 マップの表示方法に関するオプシ ョ ンが用意されて

います。  ルーティング グループ間のコネクタ、 サーバーのラベルと役割、 DC の役割の表示 /非表示を切り

替えるこ とができます。 

HP Operations Topology Viewer の使用

記載されている手順を完了して Microsoft Active Directory  ド メ イン コン ト ローラに接続する と、 ト ポロ

ジー ビューア ツールで情報を収集する こ とができ ます。 この情報はツ リ ー形式で構成され、 左側には

Microsoft Exchange Server コンポーネン トが、 右側には Microsoft Exchange Server 組織がマップ形式で

グラフ ィカルに表示されます。

ト ポロジー ビューアが提供するビューは、 サーバーに接続した時点での Active Directory のサイ ト / サー

バー複製情報 /Exchange 組織情報を反映しています。 ビューは、 手動で更新する まで変更されません。

ビューを更新するには、メニューから  [ファイル] → [データ更新] の順に選択します。 マップが更新されます。
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デフォルト の表示は、 [表示 ] メ ニューから  [プロパティ ...] を選択して変更すること ができます。 [プロパティ ]
ページにはその他の情報を示す 3 つのタブ ページがあり 、 表示を変更できます ([参照可能範囲 ] および [色と

線 ])。 

HP Operations Topology Viewer のツールバー

以下の表に、 HP Operations Topology Viewer のツールバーの機能とアイコンを示します。 

表 6　 　HP Operations Topology Viewer のツールバー

ログインしたユーザー アカウン トが、 接続する  DC への適切なアクセス権を持っている場合、 「別の資格情

報」 は不要です。 

アイコン 機能

新規ファイルを開始します。 新規ファイル

は空のグ リ ッ ド と して作成されます。

[フォレス トの追加 ] ボタンを押して、 空

のビューを埋めていきます。 [新規作成 ] ボ
タンを使用する と、 現在のビューが保存さ

れている場合に、 現在のビューに追加した

り変更したりせずに新しいビュー ([Add a 
Forest(フォレス トの追加 )] など ) に移行す

るこ とができます。

以前に保存したビューのファイルを開く こ

とができます。

現在のビューをファイルに保存します。

現在のビューをエクスポート してフォー

マッ ト  (.png、 .bmp 等 ) を選択して保存し

ます。 (デフォルトのフォーマッ トは .png 
です。 )

[フォレス トへの接続 ] ダイアログを開い

てフォレス トの追加を行ないます。 ダイア

ログでは、 サーバーの接続情報を入力しま

す。

現在の接続の情報をチェッ ク し、 データを

更新します。

マップ ビューを最大限までズームアウ ト

します。

マップ ビューを段階的にズームアウ ト し

ます。

マップ ビューをデフォルト設定に戻しま

す。
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マップ ビューを段階的にズームインしま

す。

マップ ビューを最大限までズームインし

ます。

フォレス ト内の次のト ップレベル ビュー

を表示します。

ナビゲーターを表示します。 ナビゲーター

はマップ全体 (現在の表示範囲の外側を含

みます ) のサムネイルを表示し、 現在の表

示範囲を青枠で示します。 マップ上で青枠

の位置を移動するこ とで、 マップのどこを

表示するかを簡単に変更できます。

Topology Viewer のオンライン ヘルプを

表示します。

アイコン 機能
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HP Operations Topology Viewer のメニュー

以下の表に、 HP Operations Topology Viewer のツール コマンドを示します。

表 7　 　HP Operations Topology Viewer のメニュー

メニュー コマンド 機能

ファ イル 新規作成 ... 新規ファイル (空のグ リ ッ ド ) 
を開き、 現在のビューから新

しいビューへの移行を可能に

します。

開く ... レイアウ トの保存されたファ

イルを選択して開きます。

保存 レイアウ ト をデフォルトのレ

イアウ ト と して保存します。

名前を付けて保存 ... レイアウ ト を必要なと きに

ロードできるよ うにファ イル

に保存します。

ビューへエクスポート ... 現在表示しているマップを、

フォーマッ ト を選択してファ

イルに保存します。

フォレス トの追加 ... [フォレス トの追加] ダイアロ

グを開き、 サーバーへの接続

が成功したら Exchange 組織

の情報を HP Operations 
Topology Viewer のツ リーと

マップと して生成します。

データ更新 サーバーに再接続し、 前回の

接続時点からの変更があれば

ビューを更新します。
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表示 ズーム よ り近くの視点から高倍率で

表示するズームインと、 よ り

遠くの視点から全体を表示す

るズームアウ トが可能です。 
最小値は最大限ズームアウ ト

した状態、 最大値は最大限

ズームインした状態になり ま

す。

次の表示 現在のフォレス トの次の

ビューを右ペインに表示しま

す。 

Navigator マップ全体 (現在の表示範囲

の外側を含みます ) のサムネ

イルを表示し、 現在の表示範

囲を青枠で示します。

凡例 凡例を表示します。 凡例は、

マップ中で各サーバーの隣に

表示されるシンボルの意味を

説明します。

検索のク リ ア 有効にする と、 ツ リーまたは

マップ内のサーバーやサイ ト

を右ク リ ッ ク して [ビューを

検索 ] または [ツ リーを検索 ] 
を選択した結果と してハイラ

イ ト された項目が、 [検索の

ク リ ア ] をク リ ッ クする とデ

フォルトの表示状態にもど

り、 エレ メン トのハイライ ト

表示がなくな り ます。

メニュー コマンド 機能
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表示 ツール バー Topology Viewer ツールバー 
ボタンの表示 /非表示を切り

替えます。

状況 バー Topology Viewer 状況バー 
(Topology Viewer ウ ィンド ウ

の最下部にあ り ます ) の表示 /
非表示を切り替えます。

プロパティ ... [サイ ト  ト ポロジー ビューの

プロパティ ] ダイアログを開

き、 マップ中の要素の表示 /
非表示を設定したり、 マップ

の見え方の変更を行な う こ と

ができます。

ウ ィンド ウ タイ トル ページ HP Operations Topology 
Viewer のタイ トル ページを

表示します。 

サイ ト  ト ポロジー 現在のフォレス トの Active 
Directory ト ポロジーを表示

します。

Exchange ト ポロジー 現在のフォレス トの 
Exchange メ ッセージング 
ビュー (およびルーティング 
グループ ) を表示します。

ヘルプ HP Operations Topology 
Viewer ヘルプ

HP Operations Topology 
Viewer のオンライン ヘルプ

を表示します。

HP Operations Topology 
Viewerについて ...

HP Operations Topology 
Viewer のバージ ョ ン番号を

表示します。

メニュー コマンド 機能
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HP Operations Topology Viewer のマップ

マップの接続線のラベル : どの接続線を表示するか、 およびサーバー、 ルーティング グループ、 外部メール

コネク タのラベルを表示するかど うかは、 マップを右ク リ ッ ク して [表示 ] → [ プロパテ ィ ...] で選択できま

す。 [Exchange ト ポロジー ビューのプロパティ ] ウ ィンド ウで、[色と線] タブのページを選択します。 デフォ

ルトでは接続の色分けは以下のとおりです。 

• ルーティング グループ (緑で表示 ): 別のルーティング グループに 1 つのルーティング グループを論理

的に接続するコネクタ と して機能します。 ルーティング グループには、 組織内のメールの論理ルーティ

ングが表示されます。

• 外部メール コネクタ  (青で表示 ): Microsoft Exchange 設定を持つ組織内で設定されているさまざまな

送信コネクタを表します。 外部コネクタは、 送信元サーバーと送信先サーバーの間の論理接続を示しま

す。 これらのコネクタは、Microsoft Exchange 2007 環境でのノードの実行方法と、エッジ ト ランスポー

ト  サーバーまたはハブ ト ランスポート  サーバーがインス トールされている ノードの通信方法を記述し

ます。 

― 相互

― インターネッ ト

― Exchange 2000 または Exchange 2003 を実行しているサーバー

― 他のメ ッセージング システム

送信コネクタは、 送信メ ッセージを送信します。 通信できるよ うに、 送信コネクタに 1 つ以上の送信元

サーバーを設定します。 送信元サーバーは、 そのコネク タでのメ ッセージ配信を処理する ト ランスポー

ト  サーバーと して機能します。 Microsoft Exchange Server 2007 が リモート送信先へのメ ッセージを

受信する と、 送信コネクタの送信元サーバーに送信されます。 この送信コネクタは、 送信先ド メ インに

メールを送信するよ うに設定されています。 送信コネクタは 1 つの送信元には適用されません。

• ルーティング グループ (緑で表示 ): これは、 受信者にメ ッセージをルーティングする役割を持つさまざ

まなコンポーネン ト の論理グループ化を表します。 これらのコンポーネン トは、 ハブ ト ランスポート

サーバー、 エッジ ト ランスポート  サーバー、 Microsoft Exchange 2000 または 2003 を実行するサー

バー、 その他の SMTP サーバーなど、 さまざまなサーバー間のメ ッセージ フローを制御します。 これ

らのコンポーネン トの設定を行う こ とで、 これらのサーバー間のメ ッセージ フローを制御できます。

ト ポロジー ビューアが提供するビューは、 サーバーに接続した時点での Active Directory のサイ ト / サー

バー複製情報 /Exchange 組織情報を反映しています。 ビューは、 手動で更新する まで変更されません。

ビューを更新するには、メニューから  [ファイル] → [データ更新] の順に選択します。 マップが更新されます。
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第6章 レポート作成およびグラフ作成ソリュー

シ ョ ンと  Microsoft Exchange SPI の統合
レポート とグラフを使用して、Microsoft Exchange Server 2007 コンポーネン トのパフォーマンスを完全に

把握できます。

レポート とグラフの使用

Microsoft Exchange SPI をインス トールする と、レポート とグラフの生成テンプレートがインス トールされ

ます。 これらのテンプレートは、 SMTP、 MTA、 アクティ ビティやステータスのプロセス、 IS パブリ ッ クま

たはプライベート  メールボッ クスなど、Microsoft Exchange Server 2007 の可用性や動作状況を対象と して

います。 

Microsoft Exchange SPI を HP Reporter に統合

Microsoft Exchange SPI レポート を使用するには、 EXSPI Reporter パッケージを HP Reporter サーバー

にインス ト ールする必要があ り ます。 そのためには、 Setup.exe を実行します。 これによ り、 Microsoft
Exchange SPI レポート  パッケージが Reporter サーバーにインス トールされます。 インス トールを完了し

た後、 Reporter を設定してレポートが生成されるよ うにします。 

Exchange SPI レポートおよびグラフの時間間隔

Microsoft Exchange SPI のレポートおよびグラフは、 管理ノードから管理サーバーにデータが収集される

まで使用できません。 データは毎日夜間に収集されるので、 レポート を作成するのに少なく と も  1 日分の作

業が必要とな り ます。 土曜日または日曜日に収集されるデータを必要とするタイプのレポートやグラフは、

週末を過ぎてから作成されます。
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レポート  パッケージのインストールまたはアップグレード

スタンドアロンの Reporter サーバーに Microsoft Exchange SPI レポート  パッケージをインス トールまた

はアップグレードするには、 以下の手順に従います。

1 HP Operations Smart Plug-ins DVD を挿入します。

2 Setup.exe ファ イルをダブルク リ ッ ク します (Windows の場合の管理サーバーへのインス トール手順

を参照して従います )。 ダイアログ ボッ クスが開きます。 

3 [完了 ] をク リ ッ ク してインス トールを完了します。

レポート  パッケージの設定

Microsoft Exchange SPI レポート  パッケージを設定するには、 以下の手順に従います。

1 Reporter のメ イン ウ ィンド ウを開き、 ステータス  ペインで、 Microsoft Exchange SPI レポートのアッ

プロードを含む Reporter の設定が変更されていないかど うかを確認します。

Microsoft Exchange SPI レポートは、 Reporter のメ イン ウ ィンド ウにあるすべてのグループに自動的

に割り当てられます (HPOM レポートの一覧を参照してください )。 

レポート  パッケージをインス トールする前に、 スタンドアロン管理サーバーでの Microsoft Exchange SPI
のアップグレード  (23ページ ) の手順6を完了します。
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2 必要に応じて、 レポート を割り当てるこ とによ りグループと単一システム レポート を追加します。

翌日からレポート を閲覧するこ とができます。

Microsoft Exchange SPI レポート をターゲッ ト  ノードに割り当てる手順については、 HP Reporter のヘル

プを参照して ください。 ヘルプを使用するには、 HP Reporter のメ イン ウ ィンド ウの左パネルで [レポート ]

または [検出されたシステム ] を選択し、 それを右ク リ ッ ク します。 表示されるサブメニューで、 [レポート  ヘ

ルプ ] または [検出されたシステム ヘルプ ] を選択します。 「「検出されたシステムグループ」 にレポート定義

を割り当てるには」 の項を参照して ください。 詳細については、 Reporter に含まれる  2 つのオンライン ド
キュ メン ト  ( 『コンセプ ト  ガイ ド』 および 『インス トールおよび特別構成ガイ ド』 ) も参照してください。

レポートの生成

Microsoft Exchange SPI をインス トールする と、SPI によって収集された Microsoft Exchange Server 2007
のデータを使用して、 HPOM でレポートが生成されます。 HPOM では、 夜間のスケジュールで定期的にレ

ポート を実行します。 HPOM では毎日のデータで毎晩レポートが再生成されるため、毎日更新されたレポー

ト を参照できます。

Microsoft Exchange SPI のレポート  データは、 各レポートで使用される メ ト リ ッ クに基づいて収集されま

す。 HP Reporter は、メ ト リ ッ ク変数を通じてデータを識別します。 このデータは MS SQL Reporter データ

ベースに格納されます。 

Microsoft Exchange SPI の SPI のレポートには、HPOM コンソールの [レポート ] 領域からアクセスできま

す。 すべてのレポートの詳細については、 『Microsoft Exchange SPI オンライン ヘルプ』 を参照してくださ

い。 

グループおよび単一システムの Microsoft Exchange SPI レポートは、 完全な名前で示し

ます。 たとえば、 abc.xyz.com は許容されますが、 abc は許容されません。

レポート をカスタマイズする場合、 HP Reporter をインス トールする必要があ り ます。 レポートの変更に関

する  HP Reporter のドキュ メン トについては、 『コンセプ ト  ガイ ド』 、 『インス トールおよび特別構成ガイ

ド』、 オンライン ヘルプ、 およびリ リース  ノート を参照してください。
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図6　 　 レポートの生成

Microsoft Exchange SPI を HP Performance Manager に統合

Microsoft Exchange SPI には、 一連の設定済みグラフ テンプレートが備わっています。 これらのグラフ テ
ンプレートが HP Performance Manager システムにインス トールされており、 データ  ス ト ア (CODA また

は HP Performance Agent) が管理ノード上で実行されているこ とを確認します。

Microsoft Exchange SPI を HP Performance Manager に統合するには、 以下の手順に従います。

1 Microsoft Exchange SPI をインス トールし、 設定します。

2 グラフ作成パッケージをインス トールします。 グラフ パッケージをインス トールするには、 以下の手順

に従います。

a HP Operations Smart Plug-ins DVD を挿入します。

b Setup.exe ファ イルをダブルク リ ッ ク し、 スタンドアロン管理サーバーへの Microsoft Exchange
SPI のインス トール (20ページ ) の手順に従います。

c [完了 ] を選択してインス トールを完了します。

詳細については、 HP Performance Manager のドキュ メン ト を参照してください。 
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グラフの生成

スタンドアロンの Windows サーバーの OVPMで、 Microsoft Exchange SPI のグラフを生成できます。 

図7　 　グラフの生成
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第7章 ト ラブルシューティング
この章では、Microsoft Exchange SPI のいくつかの領域のト ラブルシューティングと解決策について説明し

ます。 こ こで説明する方法には、 サポート  アシスタンスを必要とするものと必要と しないものがあ り ます。

検出のト ラブルシューテ ィング

以降のセクシ ョ ンでは、 Microsoft Exchange Server サービスの検出が失敗した場合の原因と処置について

説明します。

不十分な権限

Microsoft Exchange SPI が Microsoft Exchange Server サービスの検出に失敗する場合があ り ます。 原因と

処置は以下のとおりです。

• 原因 :  HP Operations エージェン トが検出ポリシー ([ポリシー管理 ] → [ポリシー グループ ] → [SPI for

Active Directory] →  [ja] → [Windows Server 2007] → [Manual Deploy Groups] → [Discovery]) の実行

時に使用しているアカウン トに、 Microsoft Exchange Server に接続してデータを取得する権限があ り

ません。 

• 処置 :  管理者の資格情報が検出ポ リシーに入力されているこ とを確認し、 ポ リ シーを再配布してくださ

い。

管理ノード上のバイナリの失敗

HP Operations エージェン トが HPOM 管理サーバーに対して検出したサービスの更新に失敗する場合があ

り ます。 原因と処置は以下のとおりです。

• 原因 :  Microsoft Exchange SPI の検出ポ リシーの出力が正し く フォーマッ ト された xml ファ イルでは

あ り ません。 

• 処置 :  管理ノード上で Microsoft Exchange SPI の検出バイナリ を実行して ください。 これを行うには、

以下の手順に従います。

a 管理者と して管理ノードにログインします。

b コマンド  プロンプ トから、 インス トルメンテーシ ョ ン ディ レク ト リ を開きます。

c Exchange_discovery.exe > out.xml コマンドを実行します。

d out.xml を Web ブラウザで開いて必要な xml 形式になっているかど うかを確認します。
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管理ノード上の検出バイナリのタイムアウト

管理ノード上で Microsoft Exchange SPI の検出バイナリの完了に長い時間がかかるこ とがあ り ます。 その

場合、 検出エージェン ト  (agtrep) は Microsoft Exchange SPI の検出バイナリ を完了前に強制終了します。

これによって、 Microsoft Exchange SPI の検出が失敗します。

管理ノードの System.txt にある以下のステート メン トで、agtrep による  Microsoft Exchange SPI の検出

バイナリの終了を確認できます。

• 0: ERR: Thu Nov 12 10:52:01 2009: agtrep (4732/5412): (agtrep-151) Timeout 

occurred when executing action "C:\Windows\system32\cmd.exe /C ""C:/ProgramData/

HP/HP BTO Software/bin/instrumentation/Exchange_Discovery.exe""" - will be 

terminated.

• 0: ERR: Thu Nov 12 10:52:01 2009: agtrep (4732/5412): (agtrep-133) No output 

received from discovery policy action

検出が失敗した場合の原因と処置は以下のとおりです。

• 原因 : Microsoft Exchange SPI の検出バイナリが agtrep の ACTION_TIMEOUT 期間内に完了しませ

ん。

• 処置 :  agtrep の ACTION_TIMEOUT 期間を長く し、 Microsoft Exchange SPI の検出バイナリが完了

するよ うに十分な時間を確保します。

agtrep の ACTION_TIMEOUT 期間を長くするには、 以下の手順に従います。

a 管理ノードでコマンド  プロンプ ト を開きます。

b コマンド  ovconfchg -edit を実行し、エージェン ト設定ファイルを編集します。 デフォルト値は

ACTION_TIMEOUT=3 です。

c ACTION_TIMEOUT の 値を大き く します。 たとえば、 ACTION_TIMEOUT=10 にします。

d 変更内容を保存し、 ファ イルを閉じます。

e Microsoft Exchange SPI の検出を再実行します。

ト レースによる ト ラブルシューティング

[EXSPI ト レース ] ツールの機能を利用して、管理ノードから ト ラブルシューティング情報を取得するこ とが

できます。 Microsoft Exchange SPI は、ト ラブルシューティング情報を ト レース  ファ イルと して管理ノード

の %OvDataDir%\bin\exspi\log に保存します。

このツールで、 2 つのト レース  レベルを設定するこ とができます。

• <T1Value> は、スケジューラと コレクタ  サーバーのト レース  レベルを指定します。 値は 0 または 1 です。

• <T2Value> は、 PowerShell スク リプ ト  ファ イルの ト レース  レベルを指定します。 値の範囲は 0 ～ 2
で、 2 が設定可能な最大値です。

[EXSPI ト レース ] ツールを管理ノード上で起動するには、 以下の手順に従います。 

1 コンソール ツ リーで [ツール ] → [SPI for Exchange] を展開して、 [Exchange 2007] をダブルク リ ッ ク し

ます。

各ト レース  ステート メン トには一意の ID があ り、同時に実行される同じ収集の異なるインスタンスが区別

されています。
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2 詳細ペインで、 [EXSPI ト レース ] をダブルク リ ッ ク します。 [ このツールの起動場所の選択 ] ダイアログ

が開きます。

3 ノードを選択し、[起動 ...] をク リ ッ ク します。 [Edit Parameters] ダイアログ ボッ クスが開きます。 [Edit
Parameters] ボッ クスには、 -T1 0 -T2 0 と して値が設定されています。 この値を 0 に置き換えるこ とが

できます。 -T1 では 0 または 1 に置き換え、 -T2 では 0、1、2 のいずれかに置き換えます。 これで ト レー

ス値が設定されます。 

4 [起動 ] をク リ ッ ク します。 

レポートおよびグラフのト ラブルシューテ ィング

以降のセクシ ョ ンでは、Microsoft Exchange SPI のレポートおよびグラフのデータ生成が失敗した場合の原

因と処置について説明します。

レポートおよびグラフが生成されない

レポートおよびグラフが生成されない場合があ り ます。 原因と処置は以下のとおりです。 

• 原因 :  適切なポリシーが、Microsoft Exchange SPI のそれぞれのレポートおよびグラフに配布されてい

ません。 このため、 ポ リ シーでは、 HP Reporter がレポート と して生成するデータを収集できません。

適切なポ リシーの配布に失敗する と、 HP PM でグラフを生成するこ と もできません。
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• 処置 :  Microsoft Exchange SPI の各レポートに合ったポ リシーを確認するには、 『HP Operations
Smart Plug-in for Microsoft Exchange Server リ ファレンス  ガイ ド』の「Appendix B Report」、「Report
Table」、 「Data Store」、 および 「Policy Mapping Details」 を参照して ください。 Microsoft Exchange
SPI の各グ ラ フに合ったポ リ シーを確認するには、 『HP Operations Smart Plug-in for Microsoft
Exchange Server リ ファレンス  ガイ ド』 の 「Graphs」、「Data Store」、および 「Policy Mapping Details」
を参照して ください。 上記に従ってポ リシーを配布します。

レポー ト の ト ラブルシ ューテ ィ ングに関する詳細は、 『HP Operations Smart Plug-in for Microsoft
Exchange Server オンライン ヘルプ』 の 「Troubleshooting Microsoft Exchange SPI Reports」 を参照して

ください。

データ  ログ ポリシーでデータをログ記録できない

データ  ログ ポ リシーでデータをログ記録できない場合があ り ます。 原因と処置は以下のとおりです。

• 原因 :  データ  ス ト ア (CODA や OVPA) にデータ  ソースが作成されていません。

• 処置 :  データ  ソース  EX2007_DATA が作成されているかど うかを確認して ください。 これを行うに

は、 以下の手順に従います。

a 管理者と して管理ノードにログインします。

b コマンド  プロンプ トから、 ovcodautil -obj > out.txt コマンドを実行します。

c out.txt ファ イルで、 データ  ソース  EX2007_DATA が作成されているこ とを確認します。

HTML レポートの表示中にブラウザがクラッシュする

レポート を HTML 形式で表示中に、 ブラウザがク ラ ッシュします。 原因と処置は以下のとおりです。

• 原因 :  ブラウザが大量のデータを処理できません。

• 処置 :  レポート を PDF 形式で表示してください。

Oracle データベースでレポートが失敗する

Reporter ODBC ド ラ イバが無効なため、 一部のレポートが失敗します。 

• 原因 :  Oracle データベースにアクセスする  Oracle ク ライアン トのバージ ョ ンが一致していません。

• 処置 :  Oracle 9.2.0 データベースにアクセスするには、Oracle ク ライアン ト  9.2.0 を使用し、10gR2 デー

タベースにアクセスするには、 10gR2 ク ライアン ト を使用してください。
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ポリシー名の変更

以下の Microsoft Exchange SPI ポ リシーのデフォルト名を変更する場合、SPIMetaDataXml も変更してく

ださい。

• EXSPI-8X_ReplicationCopyQueueLength_jp

• EXSPI-8X_ReplicationReplayQueueLength_jp

• EXSPI-8X-HubMonitorBlockedMails

• EXSPI-8X-EdgeMonitorBlockedMails

Microsoft Exchange SPI の各ポ リ シーに関する詳細は、 『HP Operations Smart Plug-in for Microsoft
Exchange Server オンライン ヘルプ』または『HP Operations Smart Plug-in for Microsoft Exchange Server
オンライン ヘルプ』 の PDF を参照してください。
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第8章 Microsoft Exchange SPI の削除
 Microsoft Exchange SPI は、 以下の方法で削除できます。

• DVD を使用する方法

• Windows の [ コン ト ロール パネル ] → [アプリ ケーシ ョ ンの追加と削除 ] を使用する方法

Microsoft Exchange SPI を削除するには、 管理ノードにあるすべてのポ リ シーとポ リ シー グループを削除

し、 次に管理サーバにあるすべてのポ リシーとポ リシー グループを削除します。 

DVD を使用する方法

DVD を使用して管理サーバーから  SPI を削除する前に、 手動で SPI コンポーネン ト を削除する必要があ り

ます。

Microsoft Exchange SPI コンポーネン トの削除

Microsoft Exchange SPI コンポーネン トには、ポ リシー、 レポート作成パッケージ、およびグラフ作成パッ

ケージがあ り ます。

タスク  1: すべての管理ノードから  Microsoft Exchange SPI ポリシーを削除する

1 コンソールで、 [ポリシー管理 ] フォルダを展開します。

2 [SPI for Exchange] を右ク リ ッ ク し、 [すべてのタスク ] → [ アンインストールする対象ノード ...] を選択し

ます。

3 [ポリシーをアンインストールする対象ノード ...] ウ ィンド ウで、 ポ リシーを削除する  1 つ以上のノードの

隣のチェッ ク  ボッ クスをオンにします。 

4 [OK] をク リ ッ ク します。 

タスク  2: HPOM 管理サーバーから  Microsoft Exchange SPI プログラムを削除する

1 HP Operations Smart Plug-ins DVD を挿入します。

2 画面に表示される指示に従い、 [製品の削除 ] を選択してアンインス トール手順を開始します。

3 [製品オプシ ョ ンのアンインス トール ] ウ ィンド ウで [Microsoft Exchange (SPI))] を選択し、 [次へ ] をク

リ ッ ク します。

4 次に表示されるウ ィンド ウで、 [削除 ] をク リ ッ ク します。

アンインス トールする前に、 すべての管理ノードからすべての Microsoft Exchange SPI ポ リ シーを配布解

除して ください。

ポ リシーが削除されているかど うかを確認するには、 HPOM コンソールで [ ノード ] を展開してノードを右

ク リ ッ ク し、 [表示 ] → [ポリシー インベン ト リ ] を選択します。

各ウ ィンド ウに、 Microsoft Exchange SPI のアンインス トールの状態に関する更新情報が表示されます。
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5 [完了 ] をク リ ッ ク して終了します。

タスク  3: 管理サーバーから  Microsoft Exchange SPI ポリシーを削除する

1 [ タイプ別エージェン ト  ポ リシー ] を展開します。

2 各ポリシー タイプから、 EXSPI という名前で始まるポ リシーのすべてのバージ ョ ンを削除します。

Windows の [ コン ト ロール パネル ] を使用する方法

管理サーバーから  Microsoft Exchange SPI を削除する前に、 SPI コンポーネン ト を削除します。 SPI コン

ポーネン ト を手動で削除するには、 Microsoft Exchange SPI コンポーネン トの削除のタスクを実行します。

管理サーバーからの Microsoft Exchange の削除

管理サーバーから  SPI を削除するには、 以下の手順を実行します。

1 [スタート ] メニューから  [設定 ] → [ コン ト ロール パネル] を選択し、 [アプリケーシ ョ ンの追加と削除 ] を
開きます。 

2 [HP Operations Smart Plug-ins] を選択して、 [変更] をク リ ッ ク します。

3 ウェルカム画面の [次へ] をク リ ッ ク します。

4 [Remove Programs]、 [HP Operations Smart Plug-ins] の順に選択します。

5 [EXSPI] を選択します。

6 Microsoft Exchange SPI が削除されたこ とを示すメ ッセージが表示されるまで、 指示に従います。

レポート作成パッケージの削除

レポート作成パッケージを削除するには、 以下の手順を実行します。

1 [スタート ] メニューから  [設定 ] → [ コン ト ロール パネル] を選択し、 [アプリケーシ ョ ンの追加と削除 ] を
開きます。

2 レポート作成パッケージを選択して、 [変更 ] をク リ ッ ク します。

3 HP Reporter が削除されたこ とを示すメ ッセージが表示されるまで、 指示に従います。

グラフ作成パッケージの削除

グラフ作成パッケージを削除するには、 以下の手順を実行します。

1 [スタート ] メニューから  [設定 ] → [ コン ト ロール パネル] を選択し、 [アプリケーシ ョ ンの追加と削除 ] を
開きます。

2 グラフ作成パッケージを選択して、 [変更 ] をク リ ッ ク します。

Windows のコン ト ロール パネルを使用していずれかの SPI を削除する場合は、以下の 2 つの方法を使用で

きます。(1) 選択した SPI を削除する方法、または (2) HPOM for Windows を削除する方法。 HPOM と  SPI
の両方を削除する場合は、最初にすべての Smart Plug-in を管理ノードから削除し、次に管理サーバーから

削除する必要があ り ます。 その後、 HPOM から  SPI を削除できます。
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3 HP Performance Manager が削除されたこ とを示すメ ッセージが表示されるまで、 指示に従います。

.msi ファイルを使用したレポート作成パッケージとグラフ作成

パッケージの削除

.msi ファ イルを使用して、 レポート作成パッケージとグラフ作成パッケージを削除するこ と もできます。

.msi ファイルを使用したレポート作成パッケージの削除

.msi ファ イルを使用してレポート作成パッケージを削除するには、 以下の手順を実行します。

1 次のよ うに選択します。

<SPI DVD>\SPIs\Exchange SPI Reporter Package\EXSPI-Reporter.msi

2 EXSPI-Reporter.msi を右ク リ ッ ク し、 [アンインス トール ] をク リ ッ ク します。

3 [はい ] をク リ ッ ク して、 レポート作成パッケージの削除に同意します。

.msi ファイルを使用したグラフ作成パッケージの削除

.msi ファ イルを使用してグラフ作成パッケージを削除するには、 以下の手順を実行します。

1 次のよ うに選択します。

<SPI DVD>\SPIs\EX SPI OVPM ConfigurationPackage\HPOvSpiExGc.msi

2 HPOvSpiExGc.msi を右ク リ ッ ク し、 [アンインストール ] をク リ ッ ク します。 

3 [はい ] をク リ ッ ク して、 グラフ作成パッケージの削除に同意します。
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A Microsoft Exchange SPI インストルメンテー

シ ョ ン ファイル一覧
付録 A では、 以下の表に、 Microsoft Exchange SPI のインス トルメンテーシ ョ ン カテゴ リの詳細を示しま

す。

Exchange2k7_Collector

表 8　 　 インストルメンテーシ ョ ン カテゴリの詳細 - Exchange2k7_Collector

Exchange 2k7_Core 

表 9　 　 インストルメンテーシ ョ ン カテゴリの詳細 - Exchange 2k7_Core

カテゴリ 説明

HP.OV.SPI.ExCollectorServer.
exe

ノード上で実行され、 各収集に対する  powershell 
スク リプ ト  (exspi2007.ps1) を起動するデーモン 

HP.OV.SPI.ExCollectorServer.
exe.config

HP.OV.SPI.ExCollectorServer.exe の設定ファイル

HP.OV.SPI.EXCustomCmdlets
.dll

Microsoft Exchange SPI のカスタム cmdlet を定義

します。

exspi2007.ps1 Microsoft Exchange cmdlet を作成および実行し、

データのログ記録または警告の送信 (あるいはその

両方 ) を実行する  PowerShell スク リプ ト  

カテゴリ 説明

HP.OV.SPI.ExspiTraceUtil.exe スケジューラおよびコレクタ  サーバーのト レース  
レベルを設定します。

HP.OV.SPI.ExScheduler.exe コレクタ  サーバーに対し、 必要なパラ メータを使用

して収集を起動するよ う要求します。

HP.OV.SPI.ExScheduler.exe.
config

HP.OV.SPI.ExScheduler.exe の設定ファイル

HP.OV.SPI.Terminator.exe コレクタ  サーバーを停止します。

HP.OV.SPI.ExBPAScheduler.
exe

ExBPA (Exchange Best Practices Analyzer) コマン

ド  ユーティ リ ティ を呼び出します。

CheckServiceState.exe 特定のサービスの状態を返します。

exspidatasource.exe Microsoft Exchange SPI のデータ  ソースを作成し、

コレクタ  サーバーで使用されている特定のレジス ト

リ  エン ト リ を設定します。
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EX2007_AVAILABILITY.spec Microsoft Exchange SPI のデータク ラス  
Ex2007_AVAILABILITY の列名とデータ  タイプを

指定します。

ex2007_senderid.spec Microsoft Exchange SPI のデータク ラス  
ex2007_senderid の列名とデータ  タイプを指定しま

す。

ex2007_fdsum.spec Microsoft Exchange SPI のデータク ラス  
ex2007_fdsum の列名とデータ  タイプを指定しま

す。

ex2007_isperf.spec Microsoft Exchange SPI のデータク ラス  
ex2007_isperf の列名とデータ  タイプを指定しま

す。

ex2007_mbsummary.spec Microsoft Exchange SPI のデータク ラス  
ex2007_mbsummary の列名とデータ  タイプを指定

します。

ex2007_pfsummary.spec Microsoft Exchange SPI のデータク ラス  
ex2007_pfsummary の列名とデータ  タイプを指定

します。

ex2007_mbdetail.spec Microsoft Exchange SPI のデータク ラス  
ex2007_mbdetail の列名とデータ  タイプを指定しま

す。

ex2007_pfdetail.spec Microsoft Exchange SPI のデータク ラス  
ex2007_pfdetail の列名とデータ  タイプを指定しま

す。

ex2007_isclient.spec Microsoft Exchange SPI のデータク ラス  
ex2007_isclient の列名とデータ  タイプを指定しま

す。

ex2007_umipgway.spec Microsoft Exchange SPI のデータク ラス  
ex2007_umipgway の列名とデータ  タイプを指定し

ます。

ex2007_pfperf.spec Microsoft Exchange SPI のデータク ラス  
ex2007_pfperf の列名とデータ  タイプを指定しま

す。

ex2007_pop3perf.spec Microsoft Exchange SPI のデータク ラス  
ex2007_pop3perf の列名とデータ  タイプを指定しま

す。

ex2007_mbperf.spec Microsoft Exchange SPI のデータク ラス  
ex2007_mbperf の列名とデータ  タイプを指定しま

す。

ex2007_umhunt.spec Microsoft Exchange SPI のデータク ラス  
ex2007_umhunt の列名とデータ  タイプを指定しま

す。

カテゴリ 説明
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ex2007_ummbox.spec Microsoft Exchange SPI のデータク ラス  
ex2007_ummbox の列名とデータ  タイプを指定しま

す。

ex2007_imap4perf.spec Microsoft Exchange SPI のデータク ラス  
ex2007_imap4perf の列名とデータ  タイプを指定し

ます。

ex2007_replsumm.spec Microsoft Exchange SPI のデータク ラス  
ex2007_replsumm の列名とデータ  タイプを指定し

ます。

ex2007_umpin.spec Microsoft Exchange SPI のデータク ラス  
ex2007_umpin の列名とデータ  タイプを指定しま

す。

ex2007_smtprecv.spec Microsoft Exchange SPI のデータク ラス  
ex2007_smtprecv の列名とデータ  タイプを指定し

ます。

ex2007_umsrv.spec Microsoft Exchange SPI のデータク ラス  
ex2007_umsrv の列名とデータ  タイプを指定しま

す。

ex2007_qinfo.spec Microsoft Exchange SPI のデータク ラス  
ex2007_qinfo の列名とデータ  タイプを指定します。

ex2007_smtpsend.spec Microsoft Exchange SPI のデータク ラス  
ex2007_smtpsend の列名とデータ  タイプを指定し

ます。

ex2007_agcfg.spec Microsoft Exchange SPI のデータク ラス  
ex2007_agcfg の列名とデータ  タイプを指定します。

ex2007_umplcy.spec Microsoft Exchange SPI のデータク ラス  
ex2007_umplcy の列名とデータ  タイプを指定しま

す。

EX2007_DEST.spec Microsoft Exchange SPI のデータク ラス  
EX2007_DEST の列名とデータ  タイプを指定しま

す。

EX2007_RECP.spec Microsoft Exchange SPI のデータク ラス  
EX2007_RECP の列名とデータ  タイプを指定しま

す。

EX2007_SENDER.spec Microsoft Exchange SPI のデータク ラス  
EX2007_SENDER の列名とデータ  タイプを指定し

ます。

EX2007_SOURCE.spec Microsoft Exchange SPI のデータク ラス  
EX2007_SOURCE の列名とデータ  タイプを指定し

ます。

カテゴリ 説明
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ex2007_transq.spec Microsoft Exchange SPI のデータク ラス  
ex2007_transq の列名とデータ  タイプを指定しま

す。

ex2007_umautoattendent.spec Microsoft Exchange SPI のデータク ラス  
ex2007_umautoattendent の列名とデータ  タイプを

指定します。

ex2007_umavailability.spec Microsoft Exchange SPI のデータク ラス  
ex2007_umavailability の列名とデータ  タイプを指

定します。

ex2007_umcallanswer.spec Microsoft Exchange SPI のデータク ラス  
ex2007_umcallanswer の列名とデータ  タイプを指

定します。

ex2007_umfax.spec Microsoft Exchange SPI のデータク ラス  
ex2007_umfax の列名と データ  タイプを指定します。

ex2007_umgeneral.spec Microsoft Exchange SPI のデータク ラス  
ex2007_umgeneral の列名とデータ  タイプを指定し

ます。

ex2007_umsubaccess.spec Microsoft Exchange SPI のデータク ラス  
ex2007_umsubaccess の列名とデータ  タイプを指定

します。

ex2007_blockedmails.spec Microsoft Exchange SPI のデータク ラス  
ex2007_blockedmails の列名とデータ  タイプを指定

します。

ex2007_blockedrcpts.spec Microsoft Exchange SPI のデータク ラス  
ex2007_blockedrcpts の列名とデータ  タイプを指定

します。

ex2007_spamstats.spec Microsoft Exchange SPI のデータク ラス  
ex2007_spamstats の列名とデータ  タイプを指定し

ます。

ex2007_MailFlowLatency.spec Microsoft Exchange SPI のデータク ラス  
EX2007_MFLAT の列名とデータ  タイプを指定しま

す。

CmdletCommands.xml Microsoft Exchange SPIで使用されているすべての 
Microsoft Exchange cmdlet のプロパティのデータ

タイプを一覧表示します。

spimetadata.xml Microsoft Exchange SPI のさまざまなデフォルトお

よびユーザー定義の収集を定義します。

spi_msexch.xml SHS コレクタを実行できるさまざまなモードを定義

します。

spi_msexch_chkexch.vbs SHS コレクタで使用するオペレーティング システ

ムおよび Microsoft Exchange サーバー情報を

チェッ ク します。

カテゴリ 説明
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Exchange2k7_Discovery

表 10　 　 インストルメンテーシ ョ ン カテゴリの詳細 - Exchange2k7_Discovery

spi_msexch.cmd SHS コレクタを起動する  shs_collector.pl を呼び出

します。

spi_msexch_runSHSCollector.
cmd

セルフ ヒーリ ング ク ライアン トが SHS コレクタを

実行するために使用します。

spi_msexch_shs_install.xml Microsoft Exchange SPI のインス トール フォルダ

の詳細が格納されています。

spi_msexch_shs_input.xml spi_msexch.cmd の入力パラ メータが格納されてい

ます。

register.bat HP.OV.SPI.EXCustomCmdllets.dll を登録します。

Exspi_exshell.psc1 Microsoft Exchange SPI のカスタム PS スナップイ

ンを定義します。

exbpa_wrapper.vbs ExBPACmd.exe を呼び出すラ ッパー スク リプ ト

exspi_e2k7_clust_config.js ク ラスタ  インスタンスを記述する  apminfo.xml 
ファ イルを生成します。

ovosysdetect_exspi.pl Microsoft Exchange SPI がインス トールされている

かど うかをチェッ ク します。

license.vbs Microsoft Exchange SPI のライセンスの有効性を

チェッ ク します。

カテゴリ 説明

interop.opcautolib.dll  Microsoft Exchange SPI の検出で使用される  dll

Exchange_Discovery.exe.config  Exchange_Discovery.exe の設定ファイル

discoverresult.dll Exchange_Discovery.exe が Microsoft Exchange 
SPI のサービス検出ツ リーを作成するために使用し

ます。

Exchange_Discovery.exe Microsoft Exchange のトポロジーおよびサービスを

検出します。

msexchange.apm.xml パッシブ ク ラスタ  ノードで無効にする  Microsoft 
Exchange SPI のポリシーの一覧が格納されていま

す。

ex2k7_rundiscovery.js ク ラスタ  フェイルオーバーが発生した後、 ク ラスタ  
ノード上で Microsoft Exchange SPI の検出ポ リ

シー (Exchange 2007 Discovery_jp) を実行します。

カテゴリ 説明
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